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WARRANTY
The Anritsu products listed on the title page are warranted against defects in materials and
workmanship for three years from the date of shipment.
Anritsu’s obligation covers repairing or replacing products which prove to be defective during the
warranty period. Buyers shall prepay transportation charges for equipment returned to Anritsu for
warranty repairs. Obligation is limited to the original purchaser. Anritsu is not liable for consequential
damages.  Accessories included with this product are not included in the standard warranty.

LIMITATION OF WARRANTY
The foregoing warranty does not apply to Anritsu connectors that have failed due to normal wear. Also,
the warranty does not apply to defects resulting from improper or inadequate maintenance,
unauthorized modification or misuse, or operation outside of the environmental specifications of the
product. No other warranty is expressed or implied, and the remedies provided herein are the Buyer’s
sole and exclusive remedies.

DISCLAIMER OF WARRANTY 
DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, ANRITSU COMPANY AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE
PRODUCT. THE USER ASSUMES THE ENTIRE RISK OF USING THE PRODUCT. ANY LIABILITY
OF PROVIDER OR MANUFACTURER WILL BE LIMITED EXCLUSIVELY TO PRODUCT
REPLACEMENT.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL ANRITSU COMPANY OR ITS SUPPLIERS BE LIABLE
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF ANRITSU
COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY
NOT APPLY TO YOU.

TRADEMARK ACKNOWLEDGMENTS
VNA Master and easyMap Tools are trademarks of Anritsu Company.
Acrobat Reader is a registered trademark of Adobe Corporation.

NOTICE
Anritsu Company has prepared this manual for use by Anritsu Company personnel and customers as a
guide for the proper installation, operation and maintenance of Anritsu Company equipment and
computer programs. The drawings, specifications, and information contained herein are the property of
Anritsu Company, and any unauthorized use or disclosure of these drawings, specifications, and
information is prohibited; they shall not be reproduced, copied, or used in whole or in part as the basis
for manufacture or sale of the equipment or software programs without the prior written consent of
Anritsu Company.

UPDATES
Updates, if any, can be downloaded from the Anritsu Website at:
http://www.anritsu.com
For the latest service and sales contact information in your area, please visit:
http://www.anritsu.com/contact.asp

http://www.anritsu.com
http://www.anritsu.com/Contact.asp




CE Conformity Marking

Anritsu affixes the CE Conformity marking onto its conforming products in accordance with 
Council Directives of The Council Of The European Communities in order to indicate that 
these products conform to the EMC and LVD directive of the European Union (EU).

C-tick Conformity Marking

Anritsu affixes the C-tick marking onto its conforming products in accordance with the 
electromagnetic compliance regulations of Australia and New Zealand in order to indicate 
that these products conform to the EMC regulations of Australia and New Zealand.

Notes On Export Management

This product and its manuals may require an Export License or approval by the government 
of the product country of origin for re-export from your country.

Before you export this product or any of its manuals, please contact Anritsu Company to 
confirm whether or not these items are export-controlled.

When disposing of export-controlled items, the products and manuals need to be broken or 
shredded to such a degree that they cannot be unlawfully used for military purposes.

Mercury Notification

This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated 
due to environmental considerations. Please contact your local authorities for disposal or 
recycling information.
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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu 
Company uses the following symbols to indicate safety-related information. For your own 
safety, please read the information carefully before operating the equipment.

Symbols Used in Manuals

Safety Symbols Used on Equipment and in Manuals
The following safety symbols are used inside or on the equipment near operation locations to 
provide information about safety items and operation precautions. Ensure that you clearly 
understand the meanings of the symbols and take the necessary precautions before operating 
the equipment. Some or all of the following five symbols may or may not be used on all 
Anritsu equipment. In addition, there may be other labels attached to products that are not 
shown in the diagrams in this manual.

Danger

This indicates a risk from a very dangerous condition or procedure that 
could result in serious injury or death and possible loss related to equipment 
malfunction. Follow all precautions and procedures to minimize this risk.

Warning This indicates a risk from a hazardous condition or procedure that could 
result in light-to-severe injury or loss related to equipment malfunction. 
Follow all precautions and procedures to minimize this risk.

Caution

This indicates a risk from a hazardous procedure that could result in loss 
related to equipment malfunction. Follow all precautions and procedures to 
minimize this risk.

This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle.

This indicates a compulsory safety precaution. The required operation is 
indicated symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically 
in or near the triangle.

This indicates a note. The contents are described in the box.

These indicate that the marked part should be recycled.
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For Safety

Warning Always refer to the operation manual when working near locations at 
which the alert mark, shown on the left, is attached. If the operation, 
etc., is performed without heeding the advice in the operation 
manual, there is a risk of personal injury. In addition, the equipment 
performance may be reduced. Moreover, this alert mark is sometimes 
used with other marks and descriptions indicating other dangers.

Warning

When supplying power to this equipment, connect the accessory 
3-pin power cord to a 3-pin grounded power outlet. If a grounded 
3-pin outlet is not available, use a conversion adapter and ground the 
green wire, or connect the frame ground on the rear panel of the 
equipment to ground. If power is supplied without grounding the 
equipment, there is a risk of receiving a severe or fatal electric shock.

Warning

This equipment can not be repaired by the operator. Do not attempt to 
remove the equipment covers or to disassemble internal 
components. Only qualified service technicians with a knowledge of 
electrical fire and shock hazards should service this equipment. 
There are high-voltage parts in this equipment presenting a risk of 
severe injury or fatal electric shock to untrained personnel. In 
addition, there is a risk of damage to precision components.

Caution

Electrostatic Discharge (ESD) can damage the highly sensitive 
circuits in the instrument. ESD is most likely to occur as test devices 
are being connected to, or disconnected from, the instrument’s front 
and rear panel ports and connectors. You can protect the instrument 
and test devices by wearing a static-discharge wristband. 
Alternatively, you can ground yourself to discharge any static charge 
by touching the outer chassis of the grounded instrument before 
touching the instrument’s front and rear panel ports and connectors. 
Avoid touching the test port center conductors unless you are 
properly grounded and have eliminated the possibility of static 
discharge.

Repair of damage that is found to be caused by electrostatic 
discharge is not covered under warranty.

Warning This product is supplied with a rechargeable battery that could 
potentially leak hazardous compounds into the environment. These 
hazardous compounds present a risk of injury or loss due to 
exposure. Anritsu Company recommends removing the battery for 
long-term storage of the instrument and storing the battery in a 
leak-proof plastic container. Follow the environmental storage 
requirements specified in the product technical data sheet.
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Chapter 1 — General Information

1-1 Introduction 
This chapter covers general information that includes a description, optional accessories, 
preventive maintenance, ESD verifications, and calibration requirements for the 
VNA Master model MS20xxC. Throughout this manual, the terms VNA Master and 
MS20xxC refer to the Anritsu MS2026C, MS2027C, MS2028C, MS2036C, MS2037C, and 
MS2038C Vector Network Analyzers.

MS2026C
VNA Frequency: 5 kHz to 6 GHz

MS2027C
VNA Frequency: 5 kHz to 15 GHz

MS2028C
VNA Frequency: 5 kHz to 20 GHz

MS2036C 
VNA Frequency: 5 kHz to 6 GHz
SPA Frequency: 9 kHz to 9 GHz

MS2037C 
VNA Frequency: 5 kHz to 15 GHz
SPA Frequency: 9 kHz to 15 GHz

MS2038C 
VNA Frequency: 5 kHz to 20 GHz
SPA Frequency: 9 kHz to 20 GHz

1-2 Contacting Anritsu      
To contact Anritsu, please visit:

http://www.anritsu.com/contact.asp

From here, you can select the latest sales, select service and support contact information in 
your country or region, provide online feedback, complete a “Talk to Anritsu” form to have 
your questions answered, or obtain other services offered by Anritsu.

Updated product information can be found on the Anritsu web site: http://www.anritsu.com/

Search for the product model number. The latest documentation is on the product page under 
the Library tab.

http://www.anritsu.com/en-us/products-solutions/products/MS2026C.aspx    

http://www.anritsu.com/en-us/products-solutions/products/MS2027C.aspx  

http://www.anritsu.com/en-us/products-solutions/products/MS2028C.aspx  

http://www.anritsu.com/en-us/products-solutions/products/MS2036C.aspx  

http://www.anritsu.com/en-us/products-solutions/products/MS2037C.aspx 

http://www.anritsu.com/en-us/products-solutions/products/MS2038C.aspx 

http://www.anritsu.com/en-us/products-solutions/products/ms2038c.aspx
http://www.anritsu.com/contact.asp
http://www.anritsu.com/
http://www.anritsu.com/en-us/products-solutions/products/ms2026c.aspx
http://www.anritsu.com/en-us/products-solutions/products/ms2027c.aspx
http://www.anritsu.com/en-us/products-solutions/products/ms2028c.aspx
http://www.anritsu.com/en-us/products-solutions/products/ms2036c.aspx
http://www.anritsu.com/en-us/products-solutions/products/ms2037c.aspx
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1-3 Anritsu Service Centers    
For the latest service and sales information in your area, please visit the following URL:

http://www.anritsu.com/Contact.asp and choose a country for regional contact information.

1-4 Additional Documents
This user guide is specific to the VNA Master MS20xxC (models MS2026C, MS2027C, 
MS2028C,  MS2036C, MS2037C, and MS2038C). Additional instrument functions and 
descriptions of optional measurement capabilities are described in measurement guides. 

Refer to Appendix A, “Supplemental Documentation” for a list of measurement guides and their 
Anritsu part numbers. Measurement guides are provided on the document disc that is 
shipped with each instrument. Updated measurement guides are available for download (at 
no charge) from the VNA Master product Web pages listed previously.

General and performance specifications, instrument options, standard accessories, and 
optional accessories are described in the VNA Master Technical Data Sheet, Anritsu part 
number 11410-00548.

1-5 VNA Master Specifications 
General and performance specifications, instrument options, standard accessories, and 
optional accessories are described in the VNA Master Technical Data Sheet, (Anritsu part 
number 11410-00548). The technical data sheet is available on the Anritsu Web site:
http://www.anritsu.com

http://www.anritsu.com
http://www.anritsu.com/Contact.asp
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1-6 Identifying the Connections 
The VNA Master MS2026C, MS2027C, and MS2028C have the connectors shown in 
Figure 1-1.For details, refer to Figure 2-13 on page 2-20.

The VNA Master MS2036C, MS2037C, and MS2038C have the connectors shown in 
Figure 1-2.For details, refer to Figure 2-14 on page 2-21 

Figure 1-1. MS202xC Connectors

Figure 1-2. MS203xC Connectors
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1-7 Description 
The Anritsu VNA Master instruments are portable handheld vector network analyzers 
(VNAs) featuring precise performance and essential RF capabilities. These VNA Master 
instruments are designed to conduct accurate vector-corrected 1-port magnitude, phase, and 
fault location measurements and 2-port magnitude, phase, and group delay measurements 
from 5 kHz to 20 GHz. The MS203xC models add Spectrum Analyzer capabilities that 
provide quick and accurate measurement results for monitoring, measuring, and analyzing 
signal environments. The Spectrum Analyzer offers broad spectrum analysis with frequency 
coverage to 20 GHz, impressive dynamic range, and excellent phase noise performance. 
Standard measurements include field strength, occupied bandwidth (OBW), channel power, 
adjacent channel power ratio (ACPR), and carrier to interference (C/I) ratio.

This one instrument provides all essential RF capabilities in a portable, high-performance 
platform.

Measurements: 

S-parameters, magnitude, phase, real, imaginary, SWR, Cable Loss, group delay, 
Smith Chart, time domain, distance domain, field strength, occupied bandwidth, 
channel power, adjacent channel power ratio, carrier to interference (C/I) ratio.

Time and date stamping of measurement data is automatic. The internal memory provides 
for the storage and recall of up to 1000 measurement setups and up to 1000 traces. External 
storage can be used for bulk measurement storage. Measurements and setups can be stored 
in a USB flash drive or transferred to a PC by using the included USB cable. Use 
Line Sweep Tools (LST) for certain VNA measurements and Master Software Tools (MST) for 
spectral analysis measurements (refer to Chapter 8, “Anritsu PC Software Tools” for a brief 
overview of these software tools).  

Note

Not all after-market USB drives are compatible with the VNA Master. Many drives 
come with a second partition that contains proprietary firmware. This partition must 
be removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. You might also try reformatting a drive that 
contains a single partition using FAT32 format.
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1-8 Soft Carrying Case and Tilt Bail
The soft carrying cases for the MS202xC and the MS203xC accommodate the different 
instrument sizes. The part numbers are in the Technical Data Sheet. The tilt bail is 
factory-installed on the VNA Master for use with or without the soft carrying case.

VNA Master Soft Carrying Case

The MS20xxC can be operated while in the soft carrying case. On the back of the case is a 
large storage pouch for accessories and supplies. 

To install the MS20xxC into the soft carrying case, perform the following:

1. The front panel of the case is secured with hook and loop fasteners. Fully open the front 
panel of the case.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
open and laying flat.

3. Fully open the zippered back of the case.

4. Insert the MS20xxC face down into the case, taking care that the connectors are 
properly situated in the case top opening. Figure 1-3 shows the MS20xxC in the case.

Note

Two zippers are located around the back of the case. The zipper closer to the 
MS20xxC compartment of the case opens the case back and allows access to install 
and remove the MS20xxC. The other zipper closer to the back of the case opens a 
support panel that can be used to provide support for improved stability and air flow 
while in the case. This support panel also contains the storage pouch.

Figure 1-3. Instrument Inserted Into the Soft Carrying Case
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5. Close the back panel and secure it with the zipper .

The soft carrying case includes a detachable shoulder strap that can be connected to the 
D-rings on the upper corners of the case as required for comfort or convenience. The velcro 
strap acts as a tilt bail when using the soft case as shown in Figure 1-4.

Figure 1-4. VNA Master Installed in Soft Case
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VNA Master Tilt Bail Stand 

The supplied Tilt Bail can be used for desktop operation. The tilt bail provides a backward tilt 
for improved stability and air flow. Refer to Figure 1-5.

 To deploy the tilt bail, pull the bottom of the tilt bail away from the back of the unit.

To store the tilt bail, push the bottom of the bail toward the back of the unit and snap the 
bottom of the bail into the clip on the back of the unit.

Figure 1-5. Tilt Bail Extended on VNA Master
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1-9 Preventive Maintenance    
VNA Master preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connector on the instrument and all accessories. Clean the VNA Master with 
a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of N(f) and K(f) connectors and the pins 
of N(m) and K(m) connectors should be unbroken and uniform in appearance. If you are 
unsure whether the connectors are good, then gauge the connectors to confirm that their 
dimensions are correct. Type K(f) test port connectors are availableon some models with 
Option 11.

Visually inspect the test port cables. The test port cable should be uniform in appearance, not 
stretched, kinked, dented, or broken.

1-10 Calibration Requirements – Vector Network Analyzer     
The VNA Master is a field portable unit operating in the rigors of the test environment. In 
order to ensure measurement accuracy, RF calibration (OSLT or SSLT, for example) must be 
performed prior to making a measurement in the field.

The VNA Master has no field-adjustable components. The RF (OSLT, SSLT, and SSST) 
calibration components, however, are crucial to the integrity of the calibration and should be 
periodically verified to ensure their performance. This is especially important if the 
components have been dropped or over-torqued. 

1-11 Annual Verification   
Anritsu recommends an annual calibration and performance verification of the VNA Master 
and the calibration components by local Anritsu service centers. Anritsu service centers are 
listed our web site at:
http://www.anritsu.com/Contact.asp 

Caution 
To avoid damaging the display or case, do not use solvents or abrasive 
cleaners.

Note

For best calibration results (compensation for all measurement uncertainties), 
ensure that the calibration is performed at the end of the test port or optional 
extension cable; that is, at the same point that the device that is to be tested will be 
connected. 

Caution

For best results, use an Anritsu phase stable Test Port Extension Cable, such as 
those listed in the Technical Data Sheet for your instrument (refer to Appendix A). 
Use of a typical laboratory cable to extend the VNA Master test port to the device 
under test, or any bending of the cable subsequent to the OSL or OSLT calibration, 
may cause uncompensated phase reflections inside the cable. Reflections of this 
type cause measurement errors, which are more pronounced at higher frequencies.

http://www.anritsu.com/Contact.asp
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1-12 Battery Replacement   
The battery can be replaced without the use of tools. The battery compartment is located on 
the lower left side of the instrument. Slide the battery door down (towards the bottom of the 
instrument) to remove the door. Remove the battery pack from the instrument by pulling 
straight out on the battery lanyard. Replacement is the opposite of removal.  

The battery that is supplied with the VNA Master may need charging before use. The battery 
can be charged in the VNA Master by using either the AC-DC Adapter or the 12 Volt DC 
adapter, or can be charged separately in the optional Dual Battery Charger.  

Caution
Use only Anritsu approved batteries, adapters and chargers with these 
instruments. 

1 Battery Compartment Door

Figure 1-6. MS20xxC VNA Master Battery Compartment Door

Caution

When using the Automotive 12 VDC Adapter, always verify that the supply is 
rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear of any 
dirt or debris. If the adapter plug becomes hot to the touch during operation, 
then discontinue use immediately.

1



1-13 ESD Cautions General Information

1-10 PN: 10580-00305  Rev. J MS20xxC UG

1-13 ESD Cautions     
The VNA Master, like other high performance instruments, is susceptible to ESD damage. 
Coaxial cables and antennas can easily build up a static charge, which (if allowed to discharge 
by connecting directly to the VNA Master without first discharging the static charge) may 
damage the instrument input circuitry. Operators must be aware of the potential for ESD 
damage and must take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these standards apply to the VNA Master, Anritsu 
Company recommends that any static charges that may be present be dissipated before 
connecting coaxial cables or antennas to the VNA Master. This may be as simple as 
temporarily attaching a short or load device to the cable or antenna prior to attaching to the 
VNA Master. Remember that the operator may also carry a static charge that can cause 
damage. Following the practices outlined in these standards helps to ensure that a safe 
environment exists for both personnel and equipment.

Warning

VNA Masters are supplied with a rechargeable battery that could potentially leak 
hazardous compounds into the environment. These hazardous compounds 
present a risk of injury or loss due to exposure. Anritsu Company recommends 
removing the battery for long-term storage of the instrument and storing the 
battery in a leak-proof, plastic container. Follow the environmental storage 
requirements specified in the product data sheet.
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Chapter 2 — Quick Start Guide

2-1 Introduction
This chapter provides a brief overview of the Anritsu MS20xxC VNA Master handheld Vector 
Network Analyzer. The intent of this chapter is to provide you with a starting point for 
making basic measurements. For more detailed information, refer to the specific 
measurement mode chapters in this manual.

2-2 Turning the VNA Master On for the First Time
The Anritsu VNA Master is capable of greater than two hours of continuous operation from a 
fully charged, field-replaceable battery (refer to “Battery Replacement” on page 1-9 in 
Chapter 1, “General Information”). The VNA Master can also be operated from a 12 VDC 
source (which also simultaneously charges the battery). This can be achieved with either the 
Anritsu AC-DC Adapter or 12 VDC Automotive Adapter. Both items are included as standard 
accessories (refer to the Standard and Optional Accessories in the Technical Data Sheet for 
your instrument, as listed in Appendix A). 

Caution

When using the Automotive 12 VDC Adapter,, always verify that the supply is 
rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear of any dirt 
or debris. If the adapter plug becomes hot to the touch during operation, then 
discontinue use immediately.
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To turn on the VNA Master, press the On/Off front panel button (Figure 2-1).  

The VNA Master requires approximately thirty-five seconds to complete the power-on cycle 
and load the application software. At the completion of this process, the instrument is ready 
to use.

The VNA Master performs a self test during each power-on cycle. If the self test fails, then 
refer to “Self Test or Application Self Test Error Messages” on page C-2 in 
Appendix C, “Error Messages”. For maximum accuracy, letting the instrument warm up for 
approximately 15 minutes is a good practice before performing a calibration.

1 On/Off Button

Figure 2-1. VNA Master On/Off Button (MS2028C shown) 

1
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2-3 Front Panel Overview
The VNA Master menu-driven flexible interface is intuitive and easy to use. Hard keys on the 
front panel are used to initiate function-specific menus. Five function hard keys (unlabeled) 
are located below the display. These keys vary in function depending upon the current mode 
of operation. If a function hard key has no function in the current mode, then the key label in 
the measurement display area is blank adjacent to that key. 

Located to the right of the display, the VNA Master has eight soft keys (unlabeled buttons), 
hard keys, arrow keys, and a rotary knob. The locations of all of the keys are shown in 
Figure 2-2. 

Nine of these hard keys (the number keys 1 through 9) are dual purpose, depending upon the 
current mode of operation. The dual-purpose keys are labeled with a number on the key itself 
and with the alternate function printed in blue (same color as the Shift key) on the panel 
above the key. Use the Shift key to access the functions printed on the panel above the 
number keys.

The eight soft keys (unlabeled buttons) are located adjacent to the right edge of the 
measurement display screen (or sweep window). These eight soft keys change function 
depending upon the current mode of operation and the menu selection. The current soft key 
function is indicated at the top of the active function block, which is located within the 
measurement display screen (or sweep window). The active function block displays a label for 
each active soft key. If a soft key has no function in the current mode, then the active function 
block display is blank adjacent to that soft key.

The Escape key (labeled Esc and used for aborting data entry) is the round button located 
above the eight (unlabeled) soft keys. 

The rotary knob and the keypad (and sometimes the arrow keys) can be used to change the 
value of an active parameter. The rotary knob can also be pressed to duplicate the action of 
the Enter key.

Note

Users who are familiar with the operation of previous VNA Master instruments will 
find that those menus are quite different from the menus for this current MS20xxC 
VNA Master. Some menus are the same, but those related to measurement 
setups and sweeps are very different. The intent with the MS20xxC is to provide 
you with more flexibility and choice in measurement configurations even if these 
choices result in configurations that are not very practical (such as the overlay of a 
Smith Chart on top of a rectilinear chart).
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Front Panel Overview Image  

1 Fan Exhaust Ports
2 Active Function Block or Soft Key Menu
3 Escape Key
4 Soft Keys (8 buttons)
5 Charge Fault LED
6 Battery Charge LED
7 On/Off Key
8 Directional Arrow Keys
9 Shift Key

10 Rotary Knob
11 Number Keypad
12 Enter Key
13 Fan Inlet Port
14 Function Hard Keys (5 buttons)
15 Measurement Display Screen (or Sweep Window)
16 Battery Compartment

Figure 2-2. Front Panel Overview
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Other Features on the Front Panel 

Battery Charge LED (Green)

The green Battery Charge LED (Figure 2-2, item 6) will flash if the battery is charging and 
will remain on and steady when the battery is fully charged. 

Power LED (Green) 

The Power LED (Figure 2-2, item 5) is located toward the left edge of the On/Off button. It 
remains on steady when the VNA Master is On, and blinks slowly when the VNA Master is 
Off but has external power. 

Fan Inlet and Exhaust Ports

The fan inlet (Figure 2-2, item 13) and exhaust ports (Figure 2-2, item 1) must be kept clear 
of obstructions at all times for proper ventilation and cooling of the instrument.
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2-4 Typical Vector Network Analyzer Display    
Figure 2-3 illustrates some of the key information areas of the vector network analyzer 
display screen on the VNA Master MS20xxC. The measurement and the display type that are 
illustrated here may not be the same as currently shown on your instrument. The purpose of 
the figure is to show the general areas of the display, which are labeled in the figure. Refer to 
the VNA Measurement Guide, Chapter 6, “VNA Menus” for more detailed soft key 
descriptions (refer to Appendix A for document part numbers).  

1 Instrument Settings Summary (unique to each trace)
2 Real Time Clock
3 Measurement Display Area (or Sweep Window)
4 Instrument Settings Summary (applies to all traces)
5 Battery Charge Indicator
6 Soft Key Labels (or Active Function Block)
7 Function Hard Key Labels

Figure 2-3. Vector Network Analyzer Smith Chart Display

1
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The MS20xxC features a versatile new display option for better measurement convenience. 
Because the VNA Master measures all four S-parameters simultaneously, with 
fully-reversing test signals at both Port 1 and Port 2, the measurement display provides up to 
4 simultaneous window images. As shown in Figure 2-4, each one of the S-parameters could 
be displayed in its own quarter window. Additionally, the display could be divided into three, 
two, or one graph areas. An example of four S-parameters overlaid onto one graph area is 
shown in Figure 2-5.  

Figure 2-4. 4 Traces in 4 Window Images (Quad Trace Format)
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Figure 2-5. 4 Traces in 1 Window Image (Single Trace Format)
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Instrument Settings Summary  

The instrument settings that apply to all traces are summarized in the top two rows of the 
measurement display screen (refer to item 2 in Figure 2-6). The summary includes the 
Number of Points, the IF Bandwidth, the Averaging count, the Port Power level, and the 
Bias Tee status, all of which apply to both ports. The summary also includes the Reference 
Plane Extension values, which differ for each port. 

1 Instrument Settings Summary (unique to each trace)
2 Instrument Settings Summary (applies to all traces)

Figure 2-6. Instrument Settings Summary on Measurement Display Screen

1 2
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The instrument settings that are unique to each trace are summarized in an 
information block on the left side of the measurement display screen (refer to item 1 in 
Figure 2-6). Each block contains the trace number followed by the S-parameter that is 
assigned to that trace (TR4: S22, for example). If the trace has Trace Math applied to 
it, then the math function is also displayed on that line (TR1: S11/M1, for example), 
where M1 is the memory that is associated with TR1, and the math function is 
Trace/Memory). The S-parameter that is assigned to the trace memory is shown (if 
enabled) at the top of each trace information block (M1: S11, for example). Each trace 
block also includes the Graph type, the smoothing percentage, the calibration status, 
and the scale (Resolution per Division and the Reference Value). The calibration status 
indicates whether the calibration is ON, OFF, or non-existent (--) for the specific 
S-parameter that is assigned to each trace. If the Calibration is ON, then its validity is 
also displayed (OK,?, or X).
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2-5 Typical Spectrum Analyzer Display  
Figure 2-7 illustrates some of the key information areas of the spectrum analyzer display 
screen on the VNA Master MS20xxC. The measurement and the display type that are 
illustrated here may not be the same as currently shown on your instrument. The purpose of 
the figure is to show the general areas of the display, which are labeled in the figure. Refer to 
the Spectrum Analyzer Measurement Guide for more detailed soft key descriptions. 
Measurement Guide part numbers are listed in Table A-1, “Measurement Guides” 
on page A-1 

1 Instrument Settings Summary (unique to each trace)
2 Real Time Clock
3 Measurement Display Area (or Sweep Window)
4 Instrument Settings Summary (applies to all traces)
5 Battery Charge Indicator
6 Soft Key Labels (or Active Function Block)
7 Function Hard Key Labels (specific to instrument Mode settings)

Figure 2-7. Typical Spectrum Analyzer Display Screen
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2-6 Front Panel Keys  
The term hard key refers to all of the buttons on the instrument face except for the vertical 
row of gray buttons adjacent to the measurement display. These eight gray buttons are called 
soft keys, and they are used to activate virtual soft key buttons within the measurement 
display screen. This soft key display area (soft key menu) is also called the active function 
block. Refer to Figure 2-2 (item 2) and Figure 2-3 (item 6) and Figure 2-7 (item 6).

Esc Key 

Pressing this key cancels any setting that is currently being made. Refer to Figure 2-2 
(item 3). The Esc key is located directly above the eight soft keys.

Enter Key 

Press this key to finalize data input. Pressing the rotary knob performs this same function. 
Refer to Figure 2-2 (item 12). The Enter key is located directly below the Number 3 key in the 
number keypad.

Arrow Keys 

The four arrow keys (between the rotary knob and the Esc key) are used to scroll up, down, 
left, or right. Refer to Figure 2-2 (item 8). The arrow keys can often be used to change a value 
or to change a selection from a list. This function is similar to the function of the rotary knob. 
The arrow keys are also used to move markers.

Shift Key  

Pressing the Shift key (refer to Figure 2-2, item 9 and Figure 2-8) and then a number key 
executes the function that is indicated in blue text above the number key. When the Shift key 
is pressed (when it is active), its icon is displayed in the upper right corner of the 
measurement display area between the battery charge indicator and the soft key menu label. 

Back Key 

Press this key to delete only one character, one number, or the range that is specified by the 
cursor. The Back key is located directly above the Number 7 key in the number keypad.

Plus/Minus (+/–) Key 

Press this key to change the sign of numbers that are entered with the number keys. The 
Plus/Minus (+/-) key is located directly above the Number 8 key in the number keypad.

Figure 2-8. Shift Key Icon
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Number Keypad 

These keys are used to directly input numeric values.

Rotary Knob 

Turning the rotary knob (refer to Figure 2-2, item 10) changes numerical values, scrolls 
through selectable items from a list, and moves markers. Values or items may be within a 
dialog box or an edit window. Markers are moved within the sweep window.

Pressing this knob finalizes the input function in the same manner as pressing the Enter key.

Function Hard Keys  

These five function keys (refer to Figure 2-2, item 14) are horizontally arranged adjacent to 
the measurement display screen along the lower edge. These buttons have no labels. As with 
the soft keys, they are positioned to accompany virtual key labels that are displayed to match 
instrument modes and functions. These function hard key labels change to match specific 
instrument Mode settings. Each Mode uses a specific set of Function Hard Keys. For details 
about selecting the Mode, refer to the Section “Mode Selector” on page 2-19. In some manuals, 
such as Measurement Guides, the Function Hard Keys are referred to as Main Menu Keys.

Soft Keys  

These eight gray keys have no labels (refer to Figure 2-2, item 4). They are arranged adjacent 
to the measurement display screen along the right-hand edge. They are positioned to 
accompany virtual soft key labels that are displayed to match instrument modes and 
measurement functions. These soft key labels (also called the Active Function Block) change 
as instrument measurement settings change. In some manuals, such as Measurement 
Guides, the Soft Keys are referred to as Submenu Keys.

The following Section 2-7 “Soft Key Types” describes how these keys are used:

2-7 Soft Key Types  

Select

A Select soft key has a small circle in the upper right corner of the virtual key face and is 
used to select the function or item that is displayed on the virtual soft key label. When not 
selected, the circle is gray. When selected, the circle is red to indicate that the function is 
active.

Press the key to make the selection. Press a different key to make a different selection.

A Select soft key may also be a Switching soft key. Switching soft keys show both a gray 
circle and an arrow mark (-->). 

A Select soft key may change to a Switching soft key when active. These keys show only the 
gray circle when not active, but show the arrow mark as well as the red circle when active. 
Refer to section “Switching” on page 2-14.
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Input

An Input soft key is used to select an item or a value. This type of soft key displays the setting 
parameter and the setting value on the virtual key face. When the key is pressed, a select box 
or edit box may open on the display screen, or the key face may turn a darker gray color to 
show that the setting is being made. At any time before finalizing the input, press the escape 
(Esc) key to abort the change and retain the previously existing setting.

To set or select an item or a value, use the number keys, the arrow keys, or the rotary knob. 
Press the rotary knob or the Enter key to finalize data input. If a value is being selected or 
entered, then the soft key Active Function Block may change to provide one or more soft keys 
for units, such a Hz or dB. Pressing a unit soft key sometimes finalizes the data input in the 
same manner as pressing the Enter key. If more than one unit key is displayed, then pressing 
the Enter key without first pressing a unit key selects a specific unit by default. The specific 
default units are described along with soft key descriptions that are included in the analyzer 
chapters and the Measurement Guides.

With some functions, only a specific set of values are valid. When scrolling with the Up/Down 
arrow keys or the rotary knob, only valid values are offered. If different values are set with 
the number keypad, then those values might not be accepted. Even if different values are 
accepted on the soft key face, the values may not be valid for the selected measurement. Your 
knowledge of measurement functions must be used to determine acceptable values.

Toggle

A Toggle soft key displays the setup item and the toggle states. Toggle states may be On and 
Off or may be a selection of types or values such as Reference Impedance: 50 ohm or 75 ohm.

Each press of the Toggle soft key moves the selection to the next value or item in sequence. 
The selected item or value is underlined on the virtual key face.

Switching

A Switching soft key is used to open an additional soft key menu, and it has an arrow 
mark (-->) in the lower right corner of the virtual key face. 

Some Select soft keys become Switching soft keys after being pressed (after becoming active). 
These keys may not display the arrow mark until they are active (their circle is red). An 
additional press, after the circle is red and the arrow mark is displayed, opens the additional 
soft key menu. Refer to section “Select” on page 2-13.

The Switching soft key that is labeled More opens a menu with additional soft key functions. 
The Switching soft key that is labeled Back returns to a previous soft key menu. The Back key 
has the arrow mark (<--) in the lower left corner of the virtual key face.
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2-8 Parameter Setting
Pop-up list boxes, edit boxes, and dialog boxes are used to provide selection lists and selection 
editors. Scroll through a list of items or parameters with the arrow keys or the rotary knob. 
Select numerical values by scrolling with the arrow keys or rotary knob or by entering the 
digits directly from the number keypad. These list boxes and edit boxes frequently display a 
range of possible values or limits for possible values.

Finalize the input by pressing the rotary knob or the Enter key. At any time before finalizing 
the input, press the escape (Esc) key to abort the change and retain the previously existing 
setting.

Cable parameters can be added to list boxes by creating them in Line Sweep Tools (LST). 
Signal Standard parameters can be added to list boxes by creating them in Master Software 
Tools (MST). Refer to Chapter 8, “Anritsu PC Software Tools” for a brief overview of these 
software tools.

2-9 Text Entry 
When entering text (as when saving a measurement) the soft key menu for Text Entry displays 
the characters (alphabet, hyphen, and underscore) in groups of 6 letters per soft key. 
Characters can be entered by using the rotary knob, the arrow keys, or the soft keys.

The rotary knob scrolls through the characters in a pop-up window and is pressed to select 
each character in sequence. 

Alternatively, press the a b c / d e f soft key (for example) to open another soft key menu with 
a separate key for each of these letters. The menu returns to the complete character set after 
each individual letter is entered. 

Use the arrow keys to navigate within a name or character string. Use the Shift key for 
capital letters. Press the Enter key or the rotary knob to finalize a text entry.
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Refer to Figure 2-9, Figure 2-10, and Figure 2-11. 

Figure 2-9. Text Entry Menu – Lower Case



Quick Start Guide 2-9 Text Entry

MS20xxC UG PN: 10580-00305  Rev. J 2-17

 

Figure 2-10. Text Entry Menu – Upper Case
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Figure 2-11. Text Entry Menu – Selecting Characters

Rotary Knob has scrolled 
to letter “h”
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2-10 Mode Selector    
Select a VNA Master measurement mode (such as Vector Network Analyzer or Vector Volt 
Meter) by opening the Mode Selector List Box. Press the Shift key, then the Mode (9) key, and 
choose a mode from the menu. Use the directional arrow keys or the rotary knob to highlight 
your selection, and then press the Enter key.

The modes that are available on your VNA Master depend upon the options that are installed 
and activated. Your instrument may not show the same list as Figure 2-12. 

Figure 2-12. Mode Selector List Box
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2-11 Test Panel Connectors
The connectors and indicators that are located on the test panel of the VNA Master are shown 
and described in the following sections. 

MS202xC Test Panel Connectors    

The connectors and indicators that are located on the test panel of the MS2026C,  MS2027C, 
and MS2028C are shown in Figure 2-13 and are described in the table below the figure. 

1 Fan Exhaust Port
2 GPS Antenna Input for Option 31
3 External Reference Input
4 External Trigger Input
5 RF Detector Interface (for Option 5)
6 Test Port 1 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
7 Bias Input Port 1
8 Bias Input Port 2
9 Test Port 2 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
10 Port 2 LED
11 External Power Input
12 LAN Connection
13 USB Interface, Type A (2 connectors, Full Speed USB 2.0)
14 USB Interface, Type Mini-B (Full Speed USB 2.0)
15 Headset Jack
16 Bias Status LED
17 Port 1 LED

Figure 2-13. MS202xC Test Panel Connectors
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MS203xC Test Panel Connectors  

The connectors and indicators that are located on the test panel of the MS2036C, MS2037C,  
and MS2038C are shown in Figure 2-14 and are described in the table below the figure. 

1 External Reference Input
2 Fan Exhaust Port
3 Reference Out (10 MHz)
4 Spectrum Analyzer RF Input (50 ohm)
5 Test Port 1 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
6 Bias Input Port 1
7 Bias Input Port 2
8 Test Port 2 (50 ohm) 

The corresponding LED turns green when the port is transmitting.
9 Port 2 LED

10 External Power Input
11 LAN Connection
12 USB Interface, Type A (2 connectors, Full Speed USB 2.0)
13 USB Interface, Type Mini-B (Full Speed USB 2.0)
14 Headset Jack
15 Bias Status LED
16 Port 1 LED
17 GPS Antenna Input for Option 31
18 External Trigger Input

Figure 2-14. MS203xC Test Panel Connectors
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In Figure 2-15, a waveguide-coax adapter at Test Port 1 provides test connections, and typical 
waveguide calibration components are shown below the VNA Master. 

LAN Connection    

The RJ45 connector is used to connect the VNA Master to a local area network. Refer to 
Figure 2-13, item “12” on page 2-20. Integrated into this connector are two LEDs. The amber 
LED indicates the speed of the LAN connection (ON for 10 Mb/s and OFF for 100 Mb/s), and 
the green LED flashes to show that LAN traffic is present. The instrument Ethernet address 
can be set automatically using DHCP, or manually by entering the desired IP address, 
gateway address, and subnet mask. These settings are described in more detail in 
Appendix G, “More About DHCP”.

Figure 2-15. Waveguide-Coax Adaptor and Waveguide Calibration Components

Note

An active Ethernet cable must be connected to the MS20xxC before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address. 

Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable. 

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the MS20xxC before cycling the power OFF and back ON.
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Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP and is the most common method of 
configuring a device for network use. To determine if a network is set up for DHCP, connect 
the VNA Master to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the VNA Master off, and then on. If the network is set up for DHCP, then the assigned 
IP address should be displayed briefly after the power-on sequence.

To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options soft key and the Ethernet Config soft key. The IP address is 
displayed as shown in Figure 2-16. For more information about DHCP, refer to 
Appendix G, “More About DHCP”.

Note
In order to acquire an address from a DHCP protocol network, the VNA Master 
MUST be connected to the network BEFORE being switched on.

Figure 2-16.  IP Address Assigned Using DHCP
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USB Interface - USB Type Mini-B   

The USB 2.0 interface can be used to connect the VNA Master directly to a PC. Refer to 
Figure 2-13, item “14” on page 2-20 for the USB connector location. Refer to Figure 2-17 for 
an example of a PC connection that is also using Master Software Tools. The first time that 
the VNA Master is connected to a PC, the normal USB device detection will be performed by 
the computer operating system. The CD-ROM that is shipped with the instrument contains a 
driver (for Windows 2000 and Windows XP) that is installed when Master Software Tools is 
installed. Drivers are not available for earlier versions of the Windows operating system. 
During the driver installation process, place the CD-ROM in the computer drive and specify 
that the installation wizard should search the CD-ROM for the driver.

 

USB Interface - USB Type A   

The VNA Master can also act as a USB Host, which allows various USB Flash Memory 
devices to be connected to the instrument for storing measurements and setups. Refer to 
Figure 2-13, item “13” on page 2-20.   

Note
For proper detection, either Line Sweep Tools or Master Software Tools must be 
installed on the PC prior to connecting the VNA Master to the PC USB port. 

Figure 2-17. MS2028C Connected to PC via USB Mini-B

Note

For proper operation with the instrument, USB Flash Drives should be formatted 
using either FAT (for drives that are 2GB or less) or FAT32. 

USB drives with NTFS formatting may not be correctly recognized by the 
instruments.
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2-12 VNA Master Connectors

External Power    

This is a 2.1 mm by 5.5 mm barrel connector, 12 VDC to 15 VDC, < 5.0 A. The external power 
connector is used to power the unit and for battery charging. Refer to Figure 2-13, item “11” 
on page 2-20. Input is 12 VDC to 15 VDC at up to 5.0 A. A green flashing indicator light near 
the power switch shows that the instrument battery is being charged by the external 
charging unit. The indicator is steadily illuminated when the battery is fully charged.  

Ext Trigger (50 ohm)   

Refer to Figure 2-13, item “4” on page 2-20. This connector is currently supported only in 
Spectrum Analyzer mode. It may be supported in the Vector Analyzer mode in future 
firmware releases.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

Ext Freq Ref (50 ohm)  

The BNC female connector (refer to Figure 2-13, item “3” on page 2-20) is used for connection 
of an external frequency reference. Press the External Reference soft key under the System 
menu and then the Application Options menu to set the reference to external (10 MHz). The 
amplitude of the External Reference should be between –10 dBm and +10 dBm.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

RF Detector (DIN)   

The RF detector connector (refer to Figure 2-13, item “5” on page 2-20) is used for Power 
Monitor measurements (Option 5). Refer to the table of available RF Detectors in the 
Technical Data Sheet for your instrument (refer to Appendix A). Note that this option is 
available only on the MS202xC models.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the RF 
detector connector. This 4-pin DIN connector has a bayonet shell that locks in a manner 
similar to a BNC connector. Do not overtighten this connector.

Warning

When using the AC-DC Adapter, always use a three-wire power cable connected 
to a three-wire power line outlet. If power is supplied without grounding the 
equipment in this manner, then the user is at risk of receiving a severe or fatal 
electric shock.

Note

If the battery is completely depleted, then the VNA Master may not turn on even 
when the external power supply is plugged into the unit. In that case, allow the 
battery to charge while the instrument is turned off before attempting to turn on the 
instrument.
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Port 1 (50 ohm)    

This Type-N connector (refer to Figure 2-13, item “6” on page 2-20) provides the input/output 
50 ohm interface for transmission and reflection measurements of the Vector Network 
Analyzer at Port 1. Maximum input is +23 dBm at ±50 VDC. Bias Tee output is also 
available from this port (with Option 0010). The Port 1 green LED (refer to Figure 2-13, 
item “17” on page 2-20) indicates (is illuminated) when the port is transmitting power.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

Port 2 (50 ohm)   

This Type-N connector (refer to Figure 2-13, item “9” on page 2-20) provides the input/output 
50 ohm interface for transmission and reflection measurements of the Vector Network 
Analyzer at Port 2. Maximum input is +23 dBm at ±50 VDC. Bias Tee output is also 
available from this port (with Option 0010). The Port 2 green LED (refer to Figure 2-13, 
item “10” on page 2-20) indicates (is illuminated) when the port is transmitting power.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

Type K Connectors (Option 0011) for VNA Ports   

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-K connector. Do not overtighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

Bias Input Port 1  

The BNC female connector (refer to Figure 2-13, item “7” on page 2-20) is used for external 
bias tee input that will be routed to Port 1 of the Vector Network Analyzer. Maximum input is 
±50 VDC and 500 mA.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

Bias Input Port 2 

The BNC female connector (refer to Figure 2-13, item “8” on page 2-20) is used for external 
bias tee input that will be routed to Port 2 of the Vector Network Analyzer. Maximum input is 
±50 VDC and 500 mA.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

Bias Status LED  

This LED (refer to Figure 2-13, item “16” on page 2-20) illuminates green when Internal or 
External Bias is selected. It illuminates red for any overload condition (current or voltage).
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Headset Jack  
This connector (refer to Figure 2-13, item “15” on page 2-20) is not currently used in the 
applications that are supported by these VNA Masters. The headset jack accepts a 3.5 mm 
3-wire miniature phone plug such as those commonly used with cellular telephones.
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2-13 Connector Care 
Visually inspect connectors for general wear, for cleanliness, and for damage such as bent 
pins or connector rings. Repair or replace damaged connectors immediately. Dirty connectors 
can limit the accuracy of your measurements. Damaged connectors can damage the 
instrument. Connection of cables carrying an electrostatic potential, excess power, or excess 
voltage can damage the connector or the instrument or both. Connection of cables with 
inadequate torque settings can affect measurement accuracy. Over torquing connectors can 
damage the cable, the connector, the instrument, or all of these items.

Torque values are written as (for example) 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m), 
where “lbf·in” means pounds (force) inches or “inch pounds of force”, and “N·m” means 
“Newton meters of force”.

Connecting Procedure (for Type-N and Type-K)      

1. Carefully align the connectors.

The male connector center pin must slip concentrically into the contact fingers of the 
female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight 
resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, then initially tighten by hand so that approximately 1/8 turn 
or 45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque. Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over torque the connector.

Disconnecting Procedure  

1. If a wrench is needed, then use an open-end wrench to keep the connector body from 
turning while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.



Quick Start Guide 2-13 Connector Care

MS20xxC UG PN: 10580-00305  Rev. J 2-29

GPS Antenna Connector    

This GPS antenna connection is for GPS only (Option 31 only). Refer to Figure 2-13, item “2” 
on page 2-20. 

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not overtighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

Reference Output, 10 MHz (50 ohm)

The SMA female connector (refer to Figure 2-14, item “3” on page 2-21 ) provides an output to 
the internally generated 10 MHz reference signal.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not overtighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

Spectrum Analyzer RF In (50 ohm)  

This connector (refer to Figure 2-14, item “4” on page 2-21) provides the input 50 ohm 
interface for the Spectrum Analyzer function.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

Type K Connectors (Option 0011) for RF In Port  

The K connector option configures the VNA Master with K connectors at the Spectrum 
Analyzer RF In port and at the VNA Ports.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
K connector. Do not overtighten the connector. The recommended torque is 8 lbf·in (0.9 N·m 
or 90 N·cm).

Note

The GPS antenna connection on the VNA Master is fitted with an SMA connector. 
A DC voltage (3.3 V or 5.0 V) is present on this connector to support active GPS 
antennas. Connect only supported antennas, such as the Anritsu GPS antenna 
(part number 2000-1528-R) to this port.
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2-14 Symbols and Indicators 
The symbols and indicators that appear on the display screen convey the instrument status or 
condition on the display.

Battery Symbol  

The battery symbol (Figure 2-18) above the display indicates the charge remaining in the 
battery. The colored section that is inside the symbol changes size and color with the charge 
level.

Green with Black Plug body: Battery is fully charged and external power is applied

Green: Battery is 30% to 100% charged.

Yellow: Battery is 10% to 30% charged.

Red: Battery is 0% to 10% charged. When the Battery Indicator is red,
 approximately 8 to 10 minutes of battery life remain.

Lightning Bolt: Battery is being charged (any color symbol)

When the battery is charging, either from the AC-DC Adapter or the 
12 Volt DC adapter, the symbol will change to that shown in Figure 2-19: 

The Battery Charge LED flashes when the battery is charging and remains on and steady 
when the battery is fully charged.    

Figure 2-18. Battery Symbol

Figure 2-19. Battery Symbol While charging

Note Use only Anritsu approved batteries, adapters, and chargers with this instrument.
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When the battery is not present, the battery symbol is replaced by a red plug body 
(Figure 2-20) to indicate that the instrument is running from external power. When the 
external AC adaptor is connected, the battery automatically receives a charge, and the 
battery symbol with the lightning bolt is displayed (Figure 2-19). When the battery is fully 
charged, the charging circuit shuts off and the green battery symbol (100% charged) is 
displayed without the lighting bolt (Figure 2-18)..

Hold 

A Hold message is displayed when the VNA Master is on hold. To resume sweeping, toggle 
from Hold to Run in the Sweep menu.

Single Sweep 

The Single Sweep symbol is displayed when Single Sweep is selected. Single or Continuous 
sweep can be selected under the Sweep Menu.

Figure 2-20. Battery Not Charging or Not Available
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2-15 Memory Profile and Security Issues   
This section describes the profiles of the various types of memory that are used in the 
MS20xxC VNA Master and the associated security issues that are related to those memory 
devices.

The MS20xxC has 1 GB of Flash non-volatile memory, has EEPROM memory, and has 
sufficient DRAM volatile memory for normal operation. The instrument is supplied with a 
USB memory device that plugs into the USB Type A connector. The MS20xxC does not have a 
hard drive or any other type of volatile or non-volatile memory.

The following sections describe how memory is used in the VNA Master and how it can be 
erased.

Internal Flash Memory   

This memory space is used to store the instrument firmware and factory calibration, and can 
be used to store measurements and setups that are saved by the user. 

Saved measurements and setups that are stored in the Flash memory are all deleted by the 
master reset process that is described in Section “MS20xxC Master Reset Instructions” on the 
following page. 

USB Memory Device     

The USB memory device is not required for proper operation of the instrument. The 
instrument may be directed to store measurements and setups directly to the USB memory 
device, or you may transfer the contents of the internal flash memory into the USB memory 
device for storage or data transfer purposes. The device is removable and therefore does not 
pose a security risk because it can remain in a secured area, can be externally erased by a 
computer, or can be destroyed. 

RAM Memory    

This is volatile memory that is used to store many parameters that are needed for the normal 
operation of the MS20xxC along with current measurements. This memory is reset whenever 
the instrument is restarted.

EEPROM  

This memory holds information such as the model number, serial number, and calibration 
data for the instrument. Also stored here are the operating parameters, such as frequency 
range, that are set by the user. During the master reset process, all operating parameters 
that are stored in the EEPROM are set to standard factory default values.

Note
With Option 7 enabled, the user is not able to store any measurements or setups to 
this internal flash memory.

Note
With Option 7 enabled, the user does not have access to the internal flash memory 
and, therefore, cannot transfer any contents of the internal flash memory into the 
USB memory device.
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MS20xxC Master Reset Instructions  

1. Turn the MS202xC or MS203xC On.

2. Press the Shift key then the System (8) key.

3. Press the System Options soft key.

4. Press the Reset soft key.

5. Press the Master Reset soft key.

6. A dialog box is displayed on the instrument screen to warn that all settings will be 
returned to factory default values, and that all user files will be deleted.

7. Press the Enter key to complete the master reset, or press the Esc key to abort.

8. After several seconds (which can grow to several minutes if a very large number of 
measurements have been saved in the instrument), the instrument reboots.

2-16 System Settings   
To access the System menu, press the Shift key, then the System (8) key. Refer to 
Chapter 6, “System Operations ”.

Power On Self Test

At power on, the VNA Master runs through a series of quick checks to ensure that the system 
hardware is functioning properly. Refer to “Power On Self Test” on page 6-13 and to “Self 
Test” on page 6-4.

Vector Network Analyzer Mode  

The “Application Options Menu (VNA Mode)” on page 6-7 contains the selections for Units, 
External Reference, Trace Label, Measurement Gain Range, and Time Domain (if applicable). 

Time Domain  

When the Time Domain Option (Option 2) is enabled, certain aspects of the measurements 
are determined by the settings in this menu. Refer to the Vector Network Analyzer 
Measurement Guide (listed in Appendix A) for a detailed description of this menu.

Spectrum Analyzer Mode 

The “Application Options Menu (SPA Mode)” on page 6-9 contains the Impedance setting 
selection and an Auto Ref Level selection. 

Frequency Blanking 

This feature is available with Option 7 installed. Refer to “Frequency Blanking” on page 4-5.
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2-17 File Types 
Filename extensions that are used in the VNA Master:

*.jpg JPEG images, filename.jpg

*.mna Measurements, filename.mna

*.stp Setups, filename.stp

*.s2p S2P (SnP), filename.s2p

*.spa Spectrum Analyzer measurements, filename.spa

*.csv Text file with Comma Separated Values (CSV), filename.csv

*.txt Text file with tab separated values, filename.txt

*.lim Limit lines, filename.lim (Limit lines are available only in Spectrum Analyzer 
mode.) 

 

File Management     

A description of the file menu group is in the VNA Menus chapter of the VNA Measurement 
Guide (refer to Appendix A). That section includes instructions for saving, recalling, copying, 
and deleting files.

Note

S2P is a standard ASCII text file format that is used for scattering parameters from 
a 2-Port measurement. This is a subset of SnP (where n equals the number of 
ports). An S2P file can be used as input for signal analysis.

The CSV and Text files contain setup information and final formatted data that are 
shown on the instrument display screen. This file information includes any 
post-processing that was done on the data (smoothing, trace math, time domain, 
and so forth). These files contain the data for any traces that are displayed, 
including the memory traces. They also contain the markers that are turned on 
when the file is saved. 
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Chapter 3 — Power Monitor, Option 5

3-1 Introduction    
When equipped with Option 5, Power Monitor, the MS202xC VNA Master can be used for 
making power measurements with broadband RF detectors, such as those listed in the 
Technical Data Sheet for your instrument, as listed in Appendix A. The power monitor 
displays the measured power results in dBm or Watts. 

The function hard keys that are displayed in this mode are:

Freq, Scale, Save/Recall, Measure, Marker 

Only the Save/Recall and Measure function hard keys are functional in this mode. The other 
three function hard keys provide no valid functions.

3-2 Using the Power Monitor 
1. On the VNA Master, press the Shift key, then the Mode (9) key.

2. Use the directional arrow keys or the rotary knob to highlight Power Monitor and then 
press the Enter key.

3. Connect the power sensor to the VNA Master RF Detector port.

Zeroing the Power Monitor  

1. With no power applied to the Power Detector input, press the Zero soft key. Wait for a 
few seconds while the VNA Master accumulates data samples of the quiescent power. 

2. When complete, Zero: On is displayed in the message area.

Measuring High Input Power Levels   

1. Insert an attenuator between the DUT and the RF Detector to protect the VNA Master 
so that the power level is less than or equal to +16 dBm.

2. Press the Offset soft key and enter the attenuation by using the keypad, the arrow keys, 
or the rotary knob. 

3. Press the Enter key to complete the entry.

Note Option 5 is not available in the MS203xC VNA Master models.
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Displaying Power in dBm or in Watts

Press the Units soft key to toggle between dBm and Watts.

Setting Relative Power   

1. With the desired base power level input to the VNA Master, press the Relative soft key. 
The power reading shows 100% because it is measuring the same power level. 

2. If the power is lowered by 3 dB, then the relative power will show 50%. 

3. If the power in Watts is increased from 1 Watt to 2 Watts, then the relative power will 
show 200%.

In Figure 3-2, the Units are set for dBm, the Relative Power function is Off, the Offset 
is 1 dBm, and the Zero function is set to Off. The figure is intended to illustrate the general 
layout of the Power Monitor display. The displayed image on your instrument may be 
different.

1 DUT (Device Under Test)
2 RF Out
3 Attenuator
4 RF Detector (Power Sensor)
5 RF Detector Interface (for Option 5)
6 VNA Master

Figure 3-1. Power Measurement Setup With Attenuator

3 3

1 2 3 4

5

6
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3-3 Power Monitor Display  

3-4 Power Monitor Menu  

Figure 3-2. Power Monitor Display

Units 
dBm Watts: Press this soft key to toggle units between dBm and Watts.

Relative Power 
On Off: Press this soft key to turn relative power On or Off.

Offset: Press this soft key to enter an offset value to account for any external 
attenuator that is used during a measurement.

Zero  
On Off: Press this soft key to toggle zeroing On in order to perform Zeroing 
of the power monitor detector.

Figure 3-3. Power Monitor Menu

Offset

Units
dBm             Watts

Relative Power
On                Off

Zero
On                Off

Power Monitor
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Chapter 4 — Secure Data Option 7

4-1 Introduction  
When equipped with Option 7, the MS20xxC VNA Master provides for careful management of 
confidential data for both the setup parameters and the resulting measured data. 

Highly sophisticated systems and equipment have technical applications that must remain 
secure in their operations. The particular parameters that must remain secure usually 
involve operating frequencies and a variety of other setup configurations.

To accommodate the measurements and yet preserve the data as confidential, Option 7 can be 
used to prevent any setup data or measured data from being stored on any internal memory 
location of the VNA Master. Instead, all such data are forced to be stored on removable 
memory such as an external USB memory device. 

4-2 Procedure
When saving data (setups, measurements, JPEG, and so forth) in a VNA Master with 
Option 7, the save location must be an external USB memory device. If a USB memory device 
is not connected to the instrument, then you cannot perform the save function.

You can use the following steps to change the save location while saving a file:

1. Press the Shift key, then the File (7) key.

2. Press the Save soft key.

3. Press the Change Save Location soft key.

4. Use the rotary knob or arrow keys to highlight the external USB memory device or any 
desired folder on that device.

5. Press the Create Folder soft key to create a new folder, if desired.

6. Press the Set Location soft key to set the highlighted folder or drive as the target 
location.

7. Press the Change File Type soft key to pick a different file type, if desired.

8. Use the Text Entry soft keys to enter the desired file name.

9. Press Enter to save the file.

Caution  

Note that even with Option 7 enabled, operating parameters (such as frequency 
range, power level, number of points) that are set by the user are stored in the 
VNA Master EEPROM when the VNA Master is turned OFF. These parameters 
can be erased, however, via a Master Reset operation, as described later in this 
chapter.
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4-3 Calibration Setup    
After any user calibration, the VNA Master automatically writes the calibration file to 
internal memory. This is done so that when the instrument is turned Off and then back On, 
the user calibration data are recalled, and the calibration can be applied. 

With Option 7 enabled, however, the VNA Master cannot write to internal memory. 
Therefore, the user calibration file is not automatically saved. With Option 7 enabled, when 
the instrument is turned Off and then back On, the user calibration data are not recalled, and 
the calibration cannot be applied. To save and recall the calibration, use the file save menu to 
save the setup with calibration to USB memory. Then use the file recall menu to retrieve the 
calibration.
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4-4 Memory Profile and Security Issues   
This section describes the profiles of the various types of memory that are used in the 
MS20xxC VNA Master and the associated security issues that are related to those memory 
devices.

The MS20xxC has 1 GB of Flash non-volatile memory, has EEPROM memory, and has 
sufficient DRAM volatile memory for normal operation. The instrument is supplied with a 
USB memory device that plugs into the USB Type A connector. The MS20xxC does not have a 
hard drive or any other type of volatile or non-volatile memory.

The following sections describe how memory is used in the VNA Master and how it can be 
erased.

Internal Flash Memory   

This memory space is used to store the instrument firmware and factory calibration, and can 
be used to store measurements and setups that are saved by the user. 

Saved measurements and setups that are stored in the Flash memory are all deleted by the 
master reset process that is described in Section “MS20xxC Master Reset Instructions” on the 
following page. 

USB Memory Device     

The USB memory device is not required for proper operation of the instrument. The 
instrument may be directed to store measurements and setups directly to the USB memory 
device, or you may transfer the contents of the internal flash memory into the USB memory 
device for storage or data transfer purposes. The device is removable and therefore does not 
pose a security risk because it can remain in a secured area, can be externally erased by a 
computer, or can be destroyed. 

RAM Memory    

This is volatile memory that is used to store many parameters that are needed for the normal 
operation of the MS20xxC along with current measurements. This memory is reset whenever 
the instrument is restarted.

EEPROM  

This memory holds information such as the model number, serial number, and calibration 
data for the instrument. Also stored here are the operating parameters, such as frequency 
range, that are set by the user. During the master reset process, all operating parameters 
that are stored in the EEPROM are set to standard factory default values.

Note
With Option 7 enabled, the user is not able to store any measurements or setups to 
this internal flash memory.

Note
With Option 7 enabled, the user does not have access to the internal flash memory 
and, therefore, cannot transfer any contents of the internal flash memory into the 
USB memory device.
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MS20xxC Master Reset Instructions  

1. Turn the MS202xC or MS203xC On.

2. Press the Shift key then the System (8) key.

3. Press the System Options soft key.

4. Press the Reset soft key.

5. Press the Master Reset soft key.

6. A dialog box is displayed on the instrument screen to warn that all settings will be 
returned to factory default values, and that all user files will be deleted.

7. Press the Enter key to complete the master reset, or press the Esc key to abort.

8. After several seconds (which can grow to several minutes if a very large number of 
measurements have been saved in the instrument), the instrument reboots.
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4-5 Frequency Blanking 
With Option 7 enabled, you have the ability to blank the frequency values that are displayed 
on the screen, as shown in Figure 4-1. This extra security measure allows you to use the 
instrument in any environment with sensitive frequency information blanked from the 
screen. To enable frequency blanking, navigate to the Reset menu and toggle the 
Frequency Blanking button to On (Shift-8 (System), System Options, Reset). The Reset menu 
and the Frequency Blanking button are shown in Figure 4-2. 

 

Figure 4-1. Frequency Blanking Turned On

Warning

Note that user files can still be stored to an external USB drive, and that frequency 
information is not blanked in those files. You must therefore ensure that no 
external USB devices are used to unintentionally store measurement or setup files 
when working with secure frequencies. Also, frequency information is not blanked 
from the SCPI commands that are used to remotely control the instrument. It is 
therefore up to you to ensure that no remote connections are made to the 
instrument when frequency information is being protected.
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After frequency blanking is enabled, you are not able to restore the frequency readouts. This 
feature was designed as an added security measure to ensure that the sensitive frequency 
information is protected and cannot be recovered. Following is a list of the security measures 
that have been taken to protect the frequency information:   

1. Turning off frequency blanking presets the instrument (and the frequencies) to the 
factory default settings.

2. Turning off the instrument presets the instrument to the factory default settings and 
turns off frequency blanking.

3. Presetting the instrument turns off frequency blanking and restores the factory default 
settings.

4. Frequency blanking is available only with Option 7 to ensure that user files and 
calibration files are not stored in the internal memory of the instrument. 

When you have completed making your measurements with frequency blanking turned on, 
simply turn off frequency blanking or turn off the instrument, and you can be assured that 
your sensitive frequency information cannot be restored or viewed by any other user.

Figure 4-2. Frequency Blanking Menu
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Chapter 5 — File Management

5-1 Introduction
This chapter describes the file management features of the VNA Master and describes the 
File menu. The submenus under this menu allow you to save, recall, copy, and delete files in 
the internal memory or an external USB flash drive.

5-2 File Types 
Filename extensions that are used in the VNA Master:

*.jpg JPEG images, filename.jpg

*.mna Vector Network Analyzer Measurements, filename.mna

*.stp Setups, filename.stp

*.s2p S2P (SnP), filename.s2p

*.spa Spectrum Analyzer Measurements, filename.spa

*.csv Text file with Comma Separated Values (CSV), filename.csv

*.txt Text file with tab separated values, filename.txt

*.lim Limit lines, filename.lim (Limit lines are available only in 
Spectrum Analyzer mode.) 

Note

S2P is a standard ASCII text file format that is used for scattering parameters from 
a 2-Port measurement. This is a subset of SnP (where n equals the number of 
ports). An S2P file can be used as input for signal analysis.

The CSV and Text files contain setup information and final formatted data that are 
shown on the instrument display screen. This file information includes any 
post-processing that was done on the data (smoothing, trace math, time domain, 
and so forth). These files contain the data for any traces that are displayed, 
including the memory traces. They also contain the markers that are turned on 
when the file is saved. 
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5-3 Managing Files 
Press the Shift key then the File (7) key on the number keypad to display the File menu. 
Follow the additional steps below.

Save Files

Set the Save Location 

Press Save then the Change Save Location submenu key and select the location to save files. 
You can save files to the internal memory or to an external USB flash drive. You can also 
create new folders. If an external USB flash drive is connected or disconnected, press Refresh 
Directories to update the location tree. Press the Set Location key to store the save location.

Save Measurement As

The Save Measurement As key is used to quickly save measurements with a specific file 
name. The VNA Master saves the measurement with the latest file name that was used to 
save a measurement and with a number that is automatically incremented and appended to 
the end of the file name. For instance, if the last measurement was saved with the name 
System Return Loss, Save Measurement As saves the next measurements as System Return 
Loss_#1, System Return Loss_#2, and so forth. The file name can be changed using the Save 
dialog box (Figure 5-1).

Save a Measurement

Press the Save Measurement key and enter the name for the measurement file. The 
measurement file can be stored as .MNA.

Save a Setup 

Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup 
by using the Change Type key, and then press Enter to save. 

Save a Measurement Screen as JPEG 

Press the Save submenu key, type a name for the JPEG file, confirm that the file type is 
JPEG, and press Enter to save.

Note
When navigating through the File menu, pressing the Esc key returns to the 
previous menu.
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Save Dialog Box

The save dialog box (Figure 5-1) is used to store files on the internal memory or an external 
USB flash drive. The file type, file name, and save location are set starting with this display. 
Refer to “Save Menu” on page 5-9 and “Save Location Menu” on page 5-10 for details.  

Note
The figures in this user guide are typical examples. Images on your instrument 
may not match these examples.

Figure 5-1. Save Dialog Box
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Recall Files

The recall menu enables you to view all of the Measurement and Setup files in the internal 
memory and in an external USB flash drive.

You can sort the recall menu by name, date, or type. You can also choose to view only 
measurement files or setup files by pressing File Type on the Recall dialog box and then by 
selecting the file type that you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement 
with the rotary knob or the Up/Down arrow keys, and then press Enter. 

Recall a Setup

Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file 
(.stp) with the rotary knob or the Up/Down arrow keys, and then press Enter.

Recall Dialog Box 

The Recall dialog box (Figure 5-2) opens previously saved measurements and setups. Refer 
to the “Recall Menu” on page 5-13 for additional information. 

Figure 5-2. Recall Dialog Box
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Copy Files

The steps below describe copying a file from internal memory to an external USB flash drive. 
(Copying in the reverse from USB to internal memory is accomplished by using the 
Scroll Src Dst submenu key.) Select the files to copy in the top window and the location for the 
files (to be copied) in the bottom window (Figure 5-3). Refer to the “Copy Menu” on page 5-14 
for additional information.

1. Insert a USB drive into either USB Type A port of the VNA Master. 

2. From the File main menu, press the Copy submenu key. The Copy menu and Copy 
dialog box are displayed.

3. Select the files that are to be copied. To select multiple files, highlight the first file, then 
press the Select or De-Select key to keep the file selected. The selected file is outlined in 
blue. Repeat with all the files that are to be copied. To display files in a folder, select the 
folder and press the Enter key.

4. Press the Scroll key and highlight the USB drive in the lower window using the 
Up/Down arrow keys. The Scroll submenu key toggles between source and destination, 
Src (top window) and Dst (bottom window).

5. Press the Copy key to copy the files to the USB flash drive.

Figure 5-3. Copy Dialog Box
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Delete Files 

Press the Delete submenu key. Highlight the file to be deleted with the Up/Down arrow keys. 
Press the Select or De-Select key. Selected files are outlined in blue. Press the Delete key and 
then press Enter to delete the selected file.

Delete Dialog Box

Press the Delete submenu key to open the Delete dialog box (Figure 5-4). The menus allow 
sorting by file type, name, and saved date. Refer to the “Delete Menu” on page 5-15 for 
additional information. 

Figure 5-4. Delete Dialog Box
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5-4 File Menu Overview  
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 5-5. File Menu
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5-5 File Menu  
Key Sequence: File

 

Save Measurement As: Press this soft key (submenu key) to save the 
current setup with a user defined filename. The default filename is changed 
using the Save menu. To change the default filename, type in a new filename 
with the number keyboard and press Enter. After a few seconds, the screen 
returns to File menu. Press the Save Measurement As key again and the 
new file name is used. 

Save Measurement: Press this submenu key to display the “Save Menu” 
on page 5-9. Measurements can be saved to internal memory or to a USB 
flash drive. The saved measurement can be named by using the Save menu 
keys. By default, measurements are saved to internal memory in a directory 
named /user. The save destination is set with the “Save Location Menu” 
on page 5-10.

Save: Press this submenu key to display the “Save Menu” on page 5-9 and 
the touch screen keyboard. Measurements can be saved to internal memory 
or to a USB flash drive. The saved setup, measurement, or JPEG file can be 
named in the Save menu. By default, measurements are saved to internal 
memory in a directory named /user. The save destination is set with the 
“Save Location Menu” on page 5-10.

Save on Event: Press this submenu key to display the “Save On ... Menu” 
on page 5-12. This Save on Event submenu key is displayed only in 
Spectrum Analyzer and Interference Analyzer modes (models MS203xC).

Recall Measurement: Press this submenu key to display the “Recall 
Menu” on page 5-13. This menu is for recalling measurements from internal 
memory or from a USB flash drive.

Recall: Press this submenu key to display the “Recall Menu” on page 5-13. 
This menu is for recalling measurement or setup data from internal memory 
or from a USB flash drive.

Copy: Press this submenu key to display the “Copy Menu” on page 5-14. 
The Copy menu is for copying files or folders from internal memory or a USB 
flash drive.

Delete: Press this submenu key to display the “Delete Menu” on page 5-15 
and a selection box that shows the setup and measurement names and the 
type, date, and time that the information was saved. Use the rotary knob or 
the Up/Down arrow keys to highlight the file that is to be deleted, and then 
press the Delete submenu key, then press Enter. Press the Esc key to 
cancel the operation. Note that deleted files cannot be recovered.

Figure 5-6. File Menu
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Save Menu  

Key Sequence: File > Save 

a b c: Use the top five submenu keys to enter letters and symbols in 
filenames. Press the Shift key for uppercase letters.

Use the Left/Right Arrow keys to move left and right within the text. 
Use the Back Space submenu key to move left, deleting characters.

Back Space: Press this submenu key to delete characters to the left.

Change Save Location: Press this submenu key to open the “Save Location 
Menu” on page 5-10. 

Change Type Setup/JPG/... Press this submenu key in VNA and VVM 
modes to select among the various file types available for setup and 
measurement data. This submenu key also opens the File Type menu with a 
submenu key to select Full screen or Graph Only images for JPEG file types. 
This submenu key is not displayed in Spectrum Analyzer or Interference 
Analyzer modes

Figure 5-7. Save Menu
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Save Location Menu  

Key Sequence: File > Save > Change Save Location  

Sort By
Name Date Type: Press this submenu key to sort the folders by Name, 
Type, or Date. 

Sort Order
Asc Desc: Press this submenu key to display the folder names in 
ascending or descending order.

Create Folder: Press this submenu key to create a new folder in the 
highlighted location or folder. Name the new folder in the create directory 
dialog box.

Set Location: Press this submenu key to set the current location for saving 
files and then return to the “Save Menu” on page 5-9.

Refresh Directories: Press this submenu key to update the display.

Figure 5-8. Save Location Menu

Figure 5-9. Select Save Location Dialog Box
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File Type Menu  

When saving a file, use this menu to change the file type. Typical file types are shown in 
Figure 5-11 and Figure 5-12.

Key Sequence: File > Save > Change Type   

JPEG Capture
Full Graph Only: Toggling this submenu key to Full sets the VNA Master 
to save the file with measurement data. Toggling to Graph Only saves the file 
as an image of the screen.

Figure 5-10. File Type Menu

Figure 5-11. Select File Type List Box (Spectrum Analyzer Mode)  

Figure 5-12. Select File Type List Box (VNA Mode)  
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Save On ... Menu  

In Spectrum Analyzer and Interference Analyzer modes, this menu is used to auto save 
measurements to internal memory after specific events occur. 

Key Sequence: File > Save On Event 

... Crossing Limit
On Off: Press this soft key (submenu key) to toggle the Crossing Limit On 
or Off. When On, measurements are saved to internal memory when the 
measurement has crossed a defined limit line that has been created with the 
Limit menu.

... Sweep Complete
On Off: Press this submenu key to toggle the Sweep Complete setting On 
or Off. When On, measurements are saved to internal memory after the 
current sweep is complete. When Off, a measurement is saved after every 
sweep.

Save Then Stop
On Off: Press this submenu key to toggle the Save Then Stop setting On 
or Off. When On, the sweep is stopped after a measurement is saved. When 
Off with Sweep Complete On, a measurement is saved after every sweep.

Clear All: Press this key to turn Off all three save-on-event keys:

Crossing Limit

Sweep Complete

Save Then Stop

Back: Press this key to return to the “File Menu” on page 5-8.

Figure 5-13. Save On ... Menu
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Recall Menu  

This menu and its dialog box are used to select the location from which the VNA Master 
recalls a file. Select folders or locations with the Up/Down arrow keys or the rotary knob. 

Key Sequence: File > Recall 

Sort By
Name Date Type: Press this soft key (submenu key) to sort files and 
folders by the file name, by the type of file, or by the date that the file or 
folder was saved.

Sort Order
Asc Desc: Displays the folder or file in ascending or descending order 
based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of file to be viewed. 
The file type can be changed with the Up/Down arrow keys, the rotary 
knob, or the touch screen. Press Enter to make the selection. Refer to 
Section 5-2 “File Types” for file type descriptions.

Refresh Directories: Press this key to update the display.

Figure 5-14. Recall Menu
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Copy Menu  

This menu and dialog box are used to copy folders and files. Select folders or files with the 
Up/Down arrow keys or the rotary knob. Highlight a folder and press Enter to view the 
contents. You can all use the Arrow keys. Right Arrow opens a folder to view files or 
subfolders. Left Arrow closes a folder (if it has files or subfolders).

Key Sequence: File > Copy 

Sort By
Name Type Date: Press this soft key (submenu key) to sort file and 
folder lists by name, by type of file, or by the date that a file was saved.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in 
ascending or descending order based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of files to view for 
copying. The file type can be changed with the Up/Down arrow keys, the 
rotary knob, or the touch screen. Press Enter to make the selection. Refer 
to Section 5-2 “File Types” for file type descriptions.

Refresh Directories: Press this submenu key to update the display. 

Scroll
Src Dst: Press this submenu key to use the scroll function in the Source 
Folder (Src or top panel) or in the Destination Folder (Dst or bottom panel). 
Refer to Figure 5-3.

Select or De-Select: Press this submenu key to select or deselect the files 
or folders to be copied. When selected, a file or folder is outlined in blue. 
Refer to Figure 5-3.

Copy: Press this submenu key to copy the files or folders that are selected 
in the top window to the destination that is selected in the bottom window. A 
dialog box indicates when the copying is complete. If a file with the same 
name exists in the destination folder, then a warning box is displayed to 
allow file overwrite or cancel.

Figure 5-15. Copy Menu
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Delete Menu  

This menu and dialog box are used to delete folders and files. Select folders or files with the 
Up/Down arrow keys or the rotary knob. The Delete dialog box is shown in Figure 5-4 
on page 5-6.

Key Sequence: File > Delete 

Sort By
Name Date Type: Press this soft key (submenu key) to sort files and 
folders by name, by the type of file, or by the date that the file or folder was 
saved or created.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in 
ascending or descending order based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of file to be deleted. 
The file type can be changed with the Up/Down arrow keys or the rotary 
knob. Press Enter to make the selection. Refer to Section 5-2 “File Types” 
for file type descriptions.

Select or De-Select: Press this submenu key to select or deselect the files 
or folders to be deleted. When selected, a file or folder is outlined in blue.

Delete: Press this submenu key to open the Delete dialog box. Press Enter 
to delete the selected item, or press Esc to Cancel. 

Refresh Directories: Press this submenu key to update the display.

Figure 5-16. Delete Menu

Sort By

Name    Date    Type

Sort Order

Asc              Desc

File Type

ALL

Delete

Refresh

Directories

Delete

Select
or

De-Select



5-5 File Menu File Management

5-16 PN: 10580-00305  Rev. J MS20xxC UG



MS20xxC UG PN: 10580-00305  Rev. J 6-1

Chapter 6 — System Operations 

6-1 Introduction
This chapter describes the VNA Master system operations.

• “System Menu Group Overview” on page 6-2

• “System Menu” on page 6-4

• “Preset Menu” on page 6-12

• “Power On Self Test” on page 6-13

• “Updating the VNA Master Firmware” on page 6-14

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement 
Guides that are listed in Appendix A.
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6-2 System Menu Group Overview  
To access the functions under the System menu, press the Shift key, then the System (8) key. 
Menu maps typically display all possible submenu keys, although some keys are displayed on 
the instruments only under special circumstances (refer to menu descriptions on the following 
pages). 

Application Options are specific to each operating mode, such as VNA or SPA (refer to 
“Application Options Menu (VNA Mode)” on page 6-7 and “Application Options Menu (SPA 
Mode)” on page 6-9). Consult the measurement guides for other Application Options.

Figure 6-1. System Menu Map
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6-3 Additional Menu Group  
Menu maps typically display all possible submenu keys, although some keys are displayed on 
the instruments only under special circumstances (refer to menu descriptions on the following 
pages). 

Figure 6-2. Additional Menu Map
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6-4 System Menu   
Key Sequence: Shift, System (8) 

Status: Press this submenu key to display the current system status, 
including the operating system and firmware versions, temperatures, and 
other details such as current battery information. Press Esc or Enter to return 
to normal operation.

Self Test: Press this submenu key to run a series of tests that are related to 
the performance of the motherboard hardware. Press the Esc key to abort at 
any time. The display lists a summary of those tests that have passed. If any 
test fails, then all of the performed tests are listed with Pass/Fail notification. 

If the Self Test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, then contact your Anritsu Service 
Center and report the test results. Press Esc or Enter to return to normal 
operation.

Application Self Test: Press this submenu key to run a series of tests that 
are related to the performance of the instrument hardware and that are 
specific to the current instrument application. Because high power levels are 
present at the ports during this self test, diconnect any sensitive devices 
before proceeding. Press the Esc key to abort, or press the Enter key to 
continue. The display lists a summary of those tests that have passed. If any 
test fails, then all of the performed tests are listed with Pass/Fail notification. If 
any test fails, then contact your Anritsu Service Center and report the test 
results.

GPS: Press this submenu key to open the GSP Menu. Refer to 
Chapter 7, “GPS Receiver, Option 31” for additional information.

Application Options: Submenu keys are specific to each measurement 
mode: “Application Options Menu (VNA Mode)” on page 6-7, 
“Application Options Menu (SPA Mode)” on page 6-9.

System Options: Press this submenu key to open the “System Options 
Menu” on page 6-5.

Figure 6-3. System Menu
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System Options Menu  

Key Sequence: Shift, System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys, or 
the rotary knob to select the date and time. Press Enter to accept the 
changes, or press the Esc key to return to normal operation without changing 
anything.

Ethernet Config: Press this submenu key to display the Ethernet submenu 
and to open the Ethernet Editor dialog box to set the IP address of the 
instrument. For details, refer to section “Ethernet Configuration” on page G-1 
in Appendix G, “More About DHCP”.

Language: Press this submenu key to open a list box and select a built-in 
language for the VNA Master displays. The languages that are currently 
available are: English, French, German, Spanish, Japanese, Chinese, 
Korean, Italian, and Russian. In addition, a custom language may be selected 
if it has been defined by using Master Software Tools and loaded into the 
VNA Master. The custom language may be loaded into the instrument via 
Master Software Tools. If a mode does not have language translations 
available, then English is the default language. Press Enter to accept the 
change, or press the Esc key to return to normal operation without changes.

In addition, any existing language (except English) may be edited for a better 
local translation.

Caution: A Factory Default reset (Esc + On) or Master reset (8 + On) will 
overwrite any custom settings within the VNA Master and will require that you 
reload a custom language file via Master Software Tools.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 6-10 allowing brightness control and the selection of the default color 
display, black & white display, night vision display, or a high contrast display.

Name: Press this submenu key to open a dialog box to name the instrument. 
The VNA Master can be named by using the text entry controls as described 
in section “Text Entry” on page 2-15. Press Enter to save the name.

Volume: Press this submenu key to set the speaker volume. The current 
volume setting is displayed on the screen. Use the keypad, the Up/Down 
arrow keys, or the rotary knob to change the volume, and press the Enter key 
to accept the change.

Reset: Press this submenu key to open the “Reset Menu” on page 6-11.

More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 6-6.

Figure 6-4. System Options Menu
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System Options 2/2 Menu    

Key Sequence: Shift, System (8) > System Options > More 

Remote Access Password       

This function is valid only with Master Software Tools (MST) v2.21.1 or later. After setting 
the password, reboot the instrument (normal power OFF then ON) to provide remote access 
security. Only one user then has access at any one time. 

The password is first set into the instrument, then used in MST. When prompted in MST, 
enter the password into the password text box. The password text box shown in Figure 6-6 
may differ from the text box that is displayed on your instrument. 

The password can be removed or reset by a Master Reset, by a Factory Default reset, or by a 
firmware update (which includes a restart).

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting to 
All Modes or to Not Shared. Select All Modes to have the current center fre-
quency setting and power offset setting carried over when changing measure-
ment modes. This function is not applicable to measurements that do not 
have a center frequency or power offset setting or to measurements in which 
the current center frequency or power offset setting is outside the range of the 
new measurement.

Note: This key is used only for spectrum analysis.

Set Remote Access Password: Press this submenu key to open the Pass-
word text box (Figure 6-6) and Text Entry menu. Type in the desired pass-
word. Upper case and lower case letters and the symbols - _ + . are the 
allowed password characters. Press Enter to save or Esc to cancel.

Back: Press this submenu key to return to the “System Options Menu” 
on page 6-5.

Figure 6-5. System Options Menu 2/2) 

Warning Do not use SCPI commands with this feature.

Figure 6-6. Remote Access Password Text Box

Back

System Options 2/2

Share CF &
Pwr Offset

All Modes  Not Shared

Set
Remote Access

Password

Press Shift for Caps
Use arrow keys to navigate cursor within file name

Enter to Save

Password
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6-5 Application Options Menu (VNA Mode)   
This menu is specific to the VNA application.

Key Sequence: Shift, System (8) > Application Options 

Standard VNA menus selected.

Units
m ft: Press this soft key (submenu key) to toggle the units setting to metric 
(meters, or m) or to U.S. (feet, or ft). Press Enter to accept the changes, or 
press the Esc key to return to normal operation without changing the setting.

External Reference: Press this soft key to toggle between the two choices of 
turning Off the external reference or selecting the external reference.

Trace Label
On Off: Press this soft key (submenu key) to toggle the trace labels On or 
Off.

Meas Gain Range: Press this soft key to open the “Meas Gain Range Menu 
(VNA Mode)” on page 6-9. Then select Auto or Fixed. 

Time Domain
On Off: Press this submenu key to open the “Time Domain Options Menu 
(VNA Mode)” on page 6-8.

Back: Press this soft key to return to the “System Menu” on page 6-4.

Figure 6-7. Application Options Menu (VNA Mode) 

Back
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6-6 Time Domain Options Menu (VNA Mode)  
This menu is available only when Option 2, the Time Domain Option, is installed. More 
information is available in the Vector Network Analyzer Measurement Guide (listed in 
Appendix A).

Key Sequence: Shift, System (8) > Application Options > Time Domain

VNA mode selected 

Reflection Calc in Time
One Way Round Trip: Press this soft key (submenu key) to toggle the 
setting for the calculation method that is used in the time domain (not 
distance) reflection measurements. The method can be either One Way 
(divide the total time by 2) or Round Trip.

Gate Coupled
On Off: Press this soft key (submenu key) to toggle the gate coupling On or 
Off. When set to On, the gate settings (start, stop, and so forth) for all traces 
are the same. When set to Off, each trace has a gate whose settings are 
independent of any of the other gates that are being used.

Domain Processing
Auto BP Only: Press this soft key to toggle domain processing to Auto or 
to BP Only. In Auto, the instrument selects Low Pass processing whenever 
possible and switches to Band Pass if not possible. In BP Only, the setting will 
never be Low Pass.

Back: Press this soft key to return to the “Application Options Menu (VNA 
Mode)” on page 6-7.

Figure 6-8. Application Options Menu (VNA Mode) 

Back

Time Domain Options
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6-7 Application Options Menu (SPA Mode)   
This menu is specific to the Spectrum Analyzer application.

Key Sequence: Shift, System (8) > Application Options 

6-8 Meas Gain Range Menu (VNA Mode)  
Key Sequence: Shift, System (8) > Application Options > Meas Gain Range 

SPA mode selected 

Impedance
50 Ohm 75 Ohm Other: Press this soft key (submenu key) to toggle the 
impedance setting to 50 ohm, 75 ohm, or Other impedance value. Selecting 
75 ohm selects the 7.5 dB loss of the Anritsu 12N50-75B adapter. For other 
adapters, select Other and enter the appropriate loss value.

Auto Ref Level: Press this soft key (submenu key) to adjust the position of a 
signal on the display screen so that it is approximately two divisions down 
from the top, if possible. When the key is pressed, the reference level is 
adjusted once. Auto Ref Level has no effect on the settings for the 
preamplifier or the vertical scaling.

Back: Press this soft key to return to the “System Menu” on page 6-4.

Figure 6-9. Application Options Menu (SPA Mode)

Auto: Press this soft key to set the Measurement Gain Range Mode to Auto. 
In this mode, the instrument adjusts the gain automatically to provide the best 
overall system performance (dynamic range and high level noise). 

Fixed: Press this soft key to set the Measurement Gain Range Mode to 
Fixed. In this mode, the gain of the instrument is always set to the low gain 
setting. For most applications, Auto mode is recommended. For certain types 
of filter measurements (mostly in the range less than 500 MHz), the 
instrument may toggle between low gain and high gain modes as the signal 
level rises from the noise to the pass band of the filter, resulting in extra ripple. 
Setting the Gain Range to Fixed may address that problem.

Back: Press this soft key to return to the “Application Options Menu (VNA 
Mode)”.

Figure 6-10. VNA Mode (Measurement Gain Range) Menu
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6-9 Display Settings Menu     
Key Sequence: Shift, System (8) > System Options > Display 

Brightness: Press this soft key to adjust the brightness of the display to 
optimize viewing under a wide variety of lighting conditions. Use the Up/Down 
arrow keys (increments of 25), the rotary knob (increments of 5), or the 
Left/Right arrow keys (0 or 100) to select a brightness level. Press Enter to 
accept the change.

Display Blank: Press this soft key to open a note box. Then press Enter to 
turn Off the display, or press Esc to abort. When the display is Off, turn On the 
display by three rapid key presses of any key except the power key, or by 
turning instrument power Off and On.

Default Colors: Press this soft key to set the display colors to their factory 
default condition. Use for normal viewing.

Black on White: Press this soft key to set the display colors to black and 
white. Use for printing and viewing in broad daylight conditions.

Night Vision: Press this soft key to set the display to a red-tinted color, which 
is optimized for night-time viewing.

High Contrast: Press this soft key to increase the contrast of the default 
display colors. Used for other challenging viewing conditions.

Color on White: Press this soft key to invert the black and white colors to 
produce a white background and black reticle lines with colored traces. Use 
for viewing in broad daylight conditions and for color printing.

Back: Press this soft key to return to the “System Options Menu” 
on page 6-5.

Figure 6-11. Display Settings Menu

Back
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6-10 Reset Menu  
Key Sequence: Shift, System (8) > System Options > Reset  

 

Caution

Factory Default resets erase Ethernet settings, Language, Volume, and 
Brightness. Master Resets erase all system parameters, all user saved setups and 
measurement traces, plus delete all user files in the internal memory. The 
instrument power cycles after of either of these resets.

Factory Defaults: Press this soft key to restore the instrument to the factory 
default values, including language, volume, brightness setting, and user 
created shortcut icons on the Menu screen. Press the Enter key to initiate the 
reset, and power cycle the instrument.

Master Reset: In addition to the functions described in Factory Defaults 
above, all user files in the internal memory are deleted, and the original 
language and antenna files are restored. Press the Enter key to initiate the 
Master Reset and power-cycle the instrument. Press Esc to return to normal 
operation without resetting.

Update Firmware: This soft key is used for updating the instruments's 
firmware. Refer to “Updating the VNA Master Firmware” on page 6-14 for 
additional information on firmware update.

Back: Press this soft key to return to the “System Options Menu” 
on page 6-5.

Figure 6-12. Reset Menu

Note
Reset to factory defaults with either Factory Reset (ESC+ON), or 
Master Reset (System+ON). The System button is also referred to as System (8).

Back

Master
Reset

Factory
Defaults

Update
Firmware

Reset
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6-11 Preset Menu  
Key Sequence: Shift, Preset (1) 

Preset: Press this soft key to reset the instrument to the default starting 
conditions.

Save Setup: Press this soft key to open the Save dialog box (Figure 5-1) to 
name and save the current operating settings, allowing them to be recalled 
later to return the instrument to the state it was in at the time the setup was 
saved. 

The saved setup can be named using the touch screen keyboard. Use the  
Caps key to select an upper case letter. Use the Left/Right directional 
arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 5-9 for 
details.

Recall Setup: Press this soft key to select and recall a previously stored 
instrument setup using the “Recall Menu” on page 5-13. Use the rotary 
knob, the Up/Down arrow keys, or the touchscreen to highlight the saved 
setup, and press Enter. All current instrument settings are replaced by the 
stored setup information. 

Figure 6-13. Preset Menu

Preset

Save

Recall

Preset
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6-12 Power On Self Test    
At power On, the VNA Master runs through a series of quick checks to ensure that the system 
is functioning properly.

From the “System Menu”, the System Self Test (“Self Test” on page 6-4) runs a series of tests 
that are related to the instrument itself. The Application Self Test (“Application Self Test” 
on page 6-4) runs a series of tests that are related to the current operating mode of the 
instrument. 

If the VNA Master is within the specified operating range with a charged battery, and if the 
self test fails, then contact your Anritsu Service Center (http://www.anritsu.com/Contact.asp). 

To start a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test soft key (submenu key). The Self Test results are displayed. 

3. Press Esc to continue.

http://www.anritsu.com/Contact.asp
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6-13 Updating the VNA Master Firmware  
The VNA Master is updated using a USB memory stick. Updated product information can be 
found on the Anritsu web site:

http://www.anritsu.com 

1. Search for the product model number. The firmware updates are on the product page 
under the Library tab in the “Drivers, Software Downloads” section. Follow the 
instructions on the Download Page and during the installation process.

2. After the firmware is loaded, insert the USB memory device into the USB port of the 
instrument.

3. Press the following key sequence: Shift > System (8) > System Options > Reset > 
Update Firmware. The Load Firmware main menu key (hard key) is displayed.

4. Press the Load Firmware main menu key (hard key) to display the Firmware Update 
menu and Update Application Firmware soft key.

5. Press the Update Application Firmware soft key, and the Firmware Update dialog opens.

6. Highlight each of the save choices: Save None, Save User Data, and Save & Restore 
User Data. Read through each choice carefully and then select the desired save mode.

• Save None: No attempt is made to save any user data.

• Save User Data: User data is saved to the selected external media device. 

• Save & Restore: User data is saved to the selected external media device. The 
instrument also attempts to restore the files to the instrument after the update. 

7. Press Enter to begin the firmware update process. To abort the process, press Esc, then 
choose another analyzer mode or power down.

8. The Firmware Update dialog will query you to confirm the process by pressing Enter to 
continue or by pressing Esc to abort.

9. Press Enter, and the firmware update process begins, and the Firmware Update dialog 
displays the following message:

Updating firmware. Please Wait. 

10. When complete, the instrument restarts.

Warning
If not enough memory space is available for all user data, then some data may be 
lost during this process.

Warning
If not enough memory space is available for all user data, then some data may be 
lost during this process.

http://www.anritsu.com
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Chapter 7 — GPS Receiver, Option 31

7-1 Introduction    
The VNA Master is available with a built-in GPS receiver feature (Option 31) that can 
provide latitude, longitude, altitude, and UTC timing information. A GPS antenna is not 
included with Option 31. The antenna must be ordered separately. 

In order to acquire data from the GPS satellites, the user must have line-of-sight to the 
satellites or the antenna must be placed outside without any obstructions. The GPS antenna 
must be ordered separately. Refer to the Technical Data Sheet for ordering information.

7-2 Activating the GPS Feature     
Install the Anritsu GPS antenna onto the GPS Antenna connector on the VNA Master.

1. Press the Shift key, then the System (8) key.

2. Press the GPS soft key.

3. Press the GPS On/Off soft key to toggle the GPS feature On or Off. When GPS is first 
turned on, a RED GPS icon appears at the top of the display.

4. When the GPS receiver has tracked at least three satellites, the GPS icon changes to 
GREEN. Latitude and Longitude information is displayed in the white bar on top of the 
measurement display screen. Acquiring satellites may take as long as three minutes.

Note
The GPS antenna connection on the VNA Master is fitted with an SMA female 
connector. A DC voltage is present on this connector. Do not connect anything 
other than the Anritsu GPS antenna to this port.

Figure 7-1. GPS - Red

Figure 7-2. GPS - Green

GPS

GPS
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5. Press the GPS Info soft key to view the number of tracked satellites, latitude, longitude, 
altitude, and UTC timing information, and so forth.

6. Press the Reset soft key to reset the GPS.

7. The GREEN GPS icon with a RED CROSS through it, as shown below, appears when 
GPS satellite tracking is lost (after actively tracking 3 or more satellites). The GPS 
longitude and latitude are saved in the instrument memory until the VNA Master is 
turned off or until GPS is turned off by using the GPS On/Off soft key.

Figure 7-3. GPS - Crossed

GPS



GPS Receiver, Option 31 7-3 GPS Menu

MS20xxC UG PN: 10580-00305  Rev. J 7-3

7-3 GPS Menu  

 

GPS 
On Off: Press this soft key to toggle the GPS feature On and Off.

GPS Info: Press this soft key to open a window with additional GPS 
information. Press the Esc key to close the window.

GPS Voltage 
3.3 V 5 V: Press this soft key to toggle the voltage to 3.3 volts or 5 volts. 
This voltage is supplied by the instrument to the GPS antenna.

Reset: Press this soft key to set the number of tracked satellites to 0 and to 
erase any almanac data, along with saved coordinates. The process of 
searching for and reacquiring satellites will begin again.

Back: Press this soft key to return to the.previous menu

Figure 7-4. GPS Menu
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7-4 GPS Info Window

The GPS Info window provides the following GPS information:

Tracked Satellites

Shows the number of tracked satellites (three are required to retrieve latitude and longitude, 
four are required to resolve altitude). Generally, the larger the number of satellites tracked, 
the more accurate the information.

Latitude and Longitude

Shows location in degrees, minutes, and seconds. 

Altitude

Shows altitude information in meters.

UTC

Universal Coordinated Time. 

Figure 7-5. GPS Info Window

Figure 7-6. GPS Latitude and Longitude

GPS N  37º  8′  48″   W  121º  39′  22″
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Fix Available

The cold start search sets are established to ensure that at least three satellites are acquired 
within the first couple minutes of GPS activation. When three satellites are found, the 
receiver computes an initial fix (typically in less than two minutes). Fix Not Available means 
that the initial position has not been established.

Almanac Complete  

The system Almanac contains information about the satellites in the constellation, 
ionospheric data, and special system messages. In a cold start, the GPS receiver does not have 
any navigation data, so the receiver does not have a current almanac. A complete system 
almanac is not required to achieve a first position fix. The availability of the almanac, 
however, can significantly reduce the time to first fix. 

Antenna Status

OK:

Antenna is connected properly, and antenna is working properly.

Short/Open:

A short or open exists between the antenna and the connection. If this message is 
displayed, then remove and replace the GPS antenna. If the message persists, then try 
another Anritsu GPS antenna (part number 2000-1528-R). If the message still persists, 
then contact your nearest Anritsu Service Center (refer to section “Anritsu Service 
Centers” on page 1-2).

Receiver Status

OK:

Receiver is working properly.

No GPS Time Yet:

The receiver does not have any input signal, which is usually the case when the 
antenna status is not OK. Check the antenna connection. If the antenna status is OK 
and if this message persists, then contact your nearest Anritsu Service Center.
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Other Status Messages

If any of the status messages (in the following list) persist, then the GPS receiver may be not 
working properly. In that case, contact your nearest Anritsu Service Center:
http://www.anritsu.com/Contact.asp 

• Only 1 Satellite

• Only 2 Satellites

• Only 3 Satellites

• No Usable Satellites

• Satellite unusable

• Need Initialization 

• PDOP is Too Hi 

• Undecoded Error

GPS Antenna Voltage   

Lists the voltage that is being used by the GPS antenna (3.3 V or 5 V).

GPS Antenna Current 

Lists the current draw from the GPS antenna when the voltage is applied.

7-5 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to the 
File menu in Chapter 5 of the VNA Measurement Guide (listed in Appendix A) for Save and 
Recall menu information.

The current GPS coordinates are saved with the measurement traces whenever GPS is On 
and actively tracking satellites. 

Recalling GPS Information

If the GPS coordinates were saved with a measurement trace, then when the trace is recalled, 
the coordinates that were saved are recalled as well. Refer to the File menu in Chapter 5 of 
the VNA Measurement Guide (listed in Appendix A) for more information about recalling a 
saved trace.

http://www.anritsu.com/Contact.asp
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Chapter 8 — Anritsu PC Software 
Tools

8-1 Introduction
This chapter provides a brief overview of the available PC software tools from Anritsu. For 
detailed information about specific software, refer to the Anritsu web site or the program’s 
built-in Help. Software is included with the instrument and is also available from the Anritsu 
web site: http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx.

8-2 Anritsu Tool Box
The Anritsu Tool Box is a central location to open an Anritsu measurement, visit the 
Anritsu web site, or launch several Anritsu applications. To open the Anritsu Tool Box, either 
click on the shortcut icon on the desktop or click Start and navigate through the Programs 
folder to the Anritsu folder and select Anritsu Tool Box. 

Once the Tool Box is open, move the mouse pointer over any of the application icons to view a 
short description of the application. The following pages describe three software programs 
that can be launched from the Tool Box, Line Sweep Tools, Master Software Tools (MST), and 
easyMap Tools™.

Figure 8-1. Anritsu Tool Box

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx
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8-3 Line Sweep Tools
Line Sweep Tools is a program designed to increase productivity for people who work with 
dozens of Cable traces, Antenna traces, and Passive Intermodulation (PIM) traces every day. 
Line Sweep Tools will:

• Collect sweeps from Anritsu PIM and Line Sweep gear.

• Help verify that those sweeps are done properly and that the Cable, Antenna and PIM 
sweeps meet specifications.

• Help create reports of the findings quickly and to a professional standard.

Note

The Anritsu PC Software tools do not support all of Anritsu’s handheld instruments 
or all of their measurements. Compatibility information is provided in the program’s 
Help.

Line Sweep Tools (LST) can be used for downloading and post-processing of 
certain VNA measurements and cable & antenna analysis sweeps.

Master Software Tools (MST) is primarily used for spectrum analysis 
measurements.

Figure 8-2. Line Sweep Tools
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8-4 Master Software Tools
Anritsu Master Software Tools is a PC program for transferring and editing saved 
measurements, markers, and limit lines to a PC. MST is recommended for Spectrum 
Analyzer instruments or instruments that perform spectrum analysis measurements. 

Figure 8-3. Master Software Tools 



8-5 easyMap Tools Anritsu PC Software Tools

8-4 PN: 10580-00305  Rev. J MS20xxC UG

8-5 easyMap Tools
easyMap Tools creates geo-referenced maps and can also convert floor plans for use by 
Anritsu mapping spectrum analyzers. It can also create single panel maps (.map) for legacy 
instruments or pan and zoom maps (.azm) for current instruments. Mapping of both 
interference and coverage is available while indoors or outdoors.

Figure 8-4. Captured Geo-referenced Map Ready for the Analyzer
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Appendix A — Supplemental 
Documentation

A-1 Introduction   
This appendix provides a list of supplemental documentation and software associated with 
this User Guide. The measurement guides are available as PDF files on the document disc 
that is provided with the instrument. Updated documents are available from the Anritsu Web 
site. The Web site also has links to download application notes, brochures, and online help.     

A complete suite of computer software applications are available for download: 

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

Table A-1. Measurement Guides

Title Part Number

Vector Network Analyzer Measurement Guide 10580-00289

Spectrum Analyzer Measurement Guide

   – Interference Analyzer, Channel Scanner, IF Output, 
Gated Sweep, CW Generator, AM/FM/PM Analyzer

10580-00244

Power Meter Measurement Guide

   – Power Meter, High Accuracy Power Meter

10580-00240

Table A-2. VNA Master Related Documents and Software

Title Part Number

VNA Master MS20xxC Technical Data Sheet 11410-00548

Programming Manual 10580-00306

VNA Master MS20xxC Maintenance Manual 10580-00307

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx
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Appendix B — Signal Standards

B-1 Introduction
This appendix provides a sample list of signal standards. This list can be used as a reference 
when making measurements with the VNA Master. 

Table B-1. Signal Standards

Signal Standard
Center 
(MHz)

Span 
(MHz)

Valid Channels

AMPS / EIA 553 - Uplink 859 70 1-799, 990-1023

AMPS / EIA 553 - Downlink 859 70 1-799, 990-1023

C-450 (P) - Uplink 463.5 21 1-800

C-450 (P) - Downlink 463.5 21 1-800

C-450 (SA) - Uplink 462.5 15 1-247

C-450 (SA) - Downlink 462.5 15 1-247

CDMA US Cellular - Uplink 859 70 1-799, 990-1023

CDMA US Cellular - Downlink 859 70 1-799, 990-1023

CDMA US PCS - Uplink 1920 140 1-1199

CDMA US PCS - Downlink 1920 140 1-1199

CDMA Korea PCS - Uplink 1810 120 1-599

CDMA Korea PCS - Downlink 1810 120 1-599

CDMA Japan / ARIB - Uplink 878.5 93 1-799, 801-1039, 1041-1199

CDMA Japan / ARIB - Downlink 878.5 93 1-799, 801-1039, 1041-1199

CDMA China - 1 - Uplink 916 88 0-1000, 1329-2047

CDMA China - 1 - Downlink 916 88 0-1000, 1329-2047

CDMA China - 2 - Uplink 910 76 0-1000

CDMA China - 2 - Downlink 910 76 0-1000

cdma2000 Class 0, Korea Cellular - Uplink 859 70 1-799, 990-1023

cdma2000 Class 0, Korea Cellular - Downlink 859 70 1-799, 990-1023

cdma2000 Class 0, N.A. Cellular - Uplink 859 70 1-799, 990-1023

cdma2000 Class 0, N.A. Cellular - Downlink 859 70 1-799, 990-1023

cdma2000 Class 1, N.A. PCS - Uplink 1920 140 0-1199

cdma2000 Class 1, N.A. PCS - Downlink 1920 140 0-1199

cdma2000 Class 2, (TACS Band) - Uplink 916 88 0-1100, 1329-2047

cdma2000 Class 2, (TACS Band) - Downlink 916 88 0-1100, 1329-2047

cdma2000 Class 3, (JTACS Band) - Uplink 878.5 93 1-799, 801-1039, 1041-1199

cdma2000 Class 3, (JTACS Band) - Downlink 878.5 93 1-799, 801-1039, 1041-1199

cdma2000 Class 4, Korea PCS - Uplink 1810 120 0-599

cdma2000 Class 4, Korea PCS - Downlink 1810 120 0-599



B-1 Introduction Signal Standards

B-2 PN: 10580-00305  Rev. J MS20xxC UG

cdma2000 Class 5, (NMT-450-20 kHz) - Uplink 472.5 43 1039-1473, 1792-2016

cdma2000 Class 5, (NMT-450-20 kHz) - 
Downlink

472.5 43
1039-1473, 1792-2016

cdma2000 Class 5, (NMT-450-25 kHz) - Uplink 439.5 57 1-300, 539-871

cdma2000 Class 5, (NMT-450-25 kHz) - 
Downlink

439.5 57
1-300, 539-871

cdma2000 Class 6, IMT-2000 - Uplink 2045 250 0-1199

cdma2000 Class 6, IMT-2000 - Downlink 2045 250 0-1199

cdma2000 Class 7, N.A. 700 MHz Cellular - 
Uplink

770 48
0-359

cdma2000 Class 7, N.A. 700 MHz Cellular - 
Downlink

770 48
0-359

ETACS - Uplink 916 88 0-1000, 1329-2047

ETACS - Downlink 916 88 0-1000, 1329-2047

GSM 900 - Uplink 897.4 40 1-124, 975-1023

GSM 900 - Downlink 942.4 40 1-124, 975-1023

GSM 1800 - Uplink 1747.4 80 512-885

GSM 1800 - Downlink 1842.4 80 512-885

GSM 1900 - Uplink 1879.8 80 512-810

GSM 1900 - Downlink 1959.8 80 512-810

JTACS - Uplink 878.5 93 0-1198 (even numbers only)

JTACS - Downlink 878.5 93 0-1198 (even numbers only)

MATS-E - Uplink 925 70 1-1000

MATS-E - Downlink 925 70 1-1000

N-AMPS / IS-88L - Uplink 859 70 1-799, 990-1023

N-AMPS / IS-88L - Downlink 859 70 1-799, 990-1023

N-AMPS / IS-88M - Uplink 859 70 1-799, 990-1023

N-AMPS / IS-88M - Downlink 859 70 1-799, 990-1023

N-AMPS / IS-88U - Uplink 897.5 147 1-799, 990-1023

N-AMPS / IS-88U - Downlink 897.5 147 1-799, 990-1023

NADC IS136 Cellular - Uplink 859 70 1-799, 990-1023

NADC IS136 Cellular - Downlink 859 70 1-799, 990-1023

NADC IS136 PCS - Uplink 1920 140 1-1199

NADC IS136 PCS - Downlink 1920 140 1-1199

NMT-411-25 kHz - Uplink 420.5 19 539-871

NMT-411-25 kHz - Downlink 420.5 19 539-871

NMT-450-20 kHz - Uplink 460.5 19 1039-1473

NMT-450-20 kHz - Downlink 460.5 19 1039-1473

Table B-1. Signal Standards

Signal Standard
Center 
(MHz)

Span 
(MHz)

Valid Channels
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NMT-450-25 kHz - Uplink 459 18 1-300

NMT-450-25 kHz - Downlink 459 18 1-300

NMT-470-20 kHz - Uplink 486.5 15 1972-2016

NMT-470-20 kHz - Downlink 486.5 15 1972-2016

NMT-900 - Uplink 925 70 1-1000

NMT-900 - Downlink 925 70 1-1000

NMT-900 (Offset) - Uplink 925 70 1025-2023

NMT-900 (Offset) - Downlink 925 70 1025-2023

NTACS - Uplink 878.5 93 1-1199

NTACS - Downlink 878.5 93 1-1199

PDC 800 Analog - Uplink 891.5 97 0-1680

PDC 800 Analog - Downlink 891.5 97 0-1680

PDC 1500 (JDC) - Uplink 1513 72 0-960

PDC 1500 (JDC) - Downlink 1513 72 0-960

PHS - Uplink 1906.5 23 1-77

PHS - Downlink 1906.5 23 1-77

SMR 800 - 12.5 kHz - Uplink 836 60 1-1199

SMR 800 - 12.5 kHz - Downlink 836 60 1-1199

SMR 800 - 25 kHz - Uplink 836 60 1-600

SMR 800 - 25 kHz - Downlink 836 60 1-600

SMR 1500 - Uplink 1483 60 1-479

SMR 1500 - Downlink 1483 60 1-479

TACS - Uplink 925 70 1-1000

TACS - Downlink 925 70 1-1000

UMTS/WCDMA - Uplink 1920 70 9600-9900

UMTS/WCDMA - Downlink 2110 70 10550-10850

UMTS/Region 2 - Uplink 1850 70 9250-9550

UMTS/Region 2 - Downlink 1930 70 9650-9950

802.11a 5170 84 34-161 (not all valid)

802.11b 2442 84 1-14

802.11 DS 2448 72 1-14

802.11 FH 2448.5 93 2-95

802.11g 2442 84 1-14

Table B-1. Signal Standards

Signal Standard
Center 
(MHz)

Span 
(MHz)

Valid Channels
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Appendix C — Error Messages

C-1 Introduction
This appendix provides a list of information and error messages that could be displayed on 
the VNA Master. If any error condition persists, then contact your local Anritsu Service 
Center. 

C-2 Reset Options
You can reset your VNA Master to Factory Defaults or use a Master Reset to return to the 
FULL Factory Default condition from the menu system or from the Off condition.

Reset Via Instrument Menus

From the VNA Master menu system, press the Shift key, then the System (8) key to open the 
System menu. Then press the System Options soft key to open the System Options menu. 
Then press the Reset soft key to open the Reset menu (refer to the Reset menu in Chapter 5 of 
the VNA Measurement Guide (listed in Appendix A). From the Reset menu, press either the 
Factory Defaults soft key or the Master Reset soft key. 

Reset from OFF Condition

You can also reset the VNA Master by turning it Off and then restarting under one of the 
following conditions:

Factory Defaults Reset:

Hold the Esc button while pressing the On/Off button. Continue holding the Esc button until 
the Anritsu splash screen appears. You can then release the button. The VNA Master starts 
up with Factory Default settings (refer to section “Reset Menu” on page 6-11). Throughout 
this appendix, this sequence is abbreviated as Factory Defaults (Esc+On).

Master Reset:

Hold the 8 key in the number keypad (also referred to as the System (8) key) while pressing 
the On/Off button. Continue holding the 8 key until the Anritsu splash screen appears. You 
can then release the key. The VNA Master starts up in FULL Factory Default condition (refer 
to section “Reset Menu” on page 6-11). Throughout this appendix, this sequence is 
abbreviated as Master Reset (System+On).
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C-3 Self Test or Application Self Test Error Messages

Self Test

To run self test, press Shift and System (8) and then Self Test. Refer to the results window in 
Figure C-1, which summarizes the status of several key functions in the instrument that are 
common to all applications (note that your instrument display may differ from this image). If 
any subtest shows FAILED, then check that the battery level is adequate for operation, or 
check that the temperature is within acceptable limits. Reset to factory defaults with either 
Factory Defaults (Esc+On), or Master Reset (System+On).

   

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the VNA Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.
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Figure C-1. Self Test Results Window (Vector Network Analyzer mode)

Caution
Depending upon the set mode of instrument operation, you may (or may not) see 
the full results in the Self Test list.
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Application Self Test Results Window — VNA 

Application Self Test (Vector Network Analyzer mode only)   

To run the application self test, press Shift and System (8) and then Application Self Test from 
within the desired mode. When you are in Vector Network Analyzer mode, you will see the 
results window that is shown in Figure C-2 (note that your instrument display may differ 
from this image), which summarizes the status of several key functions that are specific to 
this application. 

If the Overall Status shows Failed, then one or more elements of the Application Self Test 
have failed. This self test consists of 4 subtests:

Power Supply Test: Lists any power supply voltages that are not meeting tolerance 
specification

VCO Calibration: Lists any frequency range over which the VCO calibration is failing

Frequency Sweep: Lists any frequency range over which errors in the sweep are occurring

EEPROM: Indicates whether reading or writing (or both) to the EPPROM has failed

Figure C-2. Application Self Test Results Window (Vector Network Analyzer mode)



Error Messages C-3 Self Test or Application Self Test Error Messages

MS20xxC UG PN: 10580-00305  Rev. J C-5

If any of the subtests shows FAILED, then check that the battery level is adequate for 
operation or that temperature is within acceptable limits. Reset to factory defaults with 
either Factory Defaults (Esc+On), or Master Reset (System+On). 

Application Self Test Results Window — SPA 

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the VNA Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.

Figure C-3. Application Self Test Results Window (Spectrum Analyzer mode)



C-4 Operation Error Messages Error Messages

C-6 PN: 10580-00305  Rev. J MS20xxC UG

C-4 Operation Error Messages

Fan Failure

The system has determined that the fan should be running due to the internal temperature of 
the unit, but cannot detect that the fan is actually running. 

It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan 
will vary the speed in relation to the internal temperature of the instrument (refer to 
Figure C-4). The fan will turn on at low speed when the internal temperature of the 
instrument reaches 44ºC, and will increase the fan speed to maximum at 54ºC. As the 
internal temperature of the instrument decreases, the fan will reduce speed until the 
temperature reaches 39ºC, at which point the fan will turn off. 

High Temp Warning

The internal temperature has reached an excessive level, 85ºC. Verify that the ventilation 
openings are unobstructed and that the fan is running. Internal temperatures may be 
manually verified by using the SELF TEST function. Turn off the unit and allow the 
temperature to cool down. If the fault is not resolved and the internal temperature reaches 
90ºC, then a countdown of 10 seconds will begin. The countdown gives the user a chance to 
save the current setup before the instrument turns itself off (before internal temperatures 
can cause any damage). If the error persists after removing any obstructions and allowing the 
unit to cool, then reset to the factory defaults with Factory Defaults (Esc+On), or 
Master Reset (System+On). 

Operation not Permitted in Recall Mode

Attempted to perform an operation on a recalled trace. Many operations are valid only on a 
live or active trace.

Figure C-4. Fan Speed vs. Temperature

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the VNA Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.

FAN
SPEED

OFF LOW HIGH HI T
EMP W

ARNIN
G

AUTO S
HUT O

FF

Temperature Rising

FAN
SPEED

OFF LOW HIGH

Temperature Falling

TEMP
39 41 43 45 47 49 51 53-100 85 90 +100

oC
40 42 44 46 48 50 52 54



Error Messages C-4 Operation Error Messages

MS20xxC UG PN: 10580-00305  Rev. J C-7

PMON PLD Fail

Unable to communicate with the Power Monitor PCBA.

Power Supply 

Power Supply failed. Charge the battery.

Error Saving File. General Error Saving File 

An error was detected while saving a file. Try again. 
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C-5 Vector Network Analyzer Specific Warning Messages

Bias Tee cannot be enabled for start freq < 2MHz.

Adjust frequency before turning On the Bias Tee. 

The start frequency cannot be set less than 2 MHz when the internal or external Bias Tee is 
turned On. Set the frequency to a value larger than or equal to 2 MHz, and then turn on the 
Bias Tee.

Bias Tee is not allowed for start freq < 2MHz. 

Turn Off Bias Tee before changing the freq. 

The internal or external Bias Tee cannot be turned on when the start frequency is set to less 
than 2 MHz. Turn off the Bias Tee, and then adjust the start frequency to the desired value 
less than 2 MHz.

Changing Source Power 

Changing Source Power will affect the accuracy of the current calibration.

While Cal Correction is turned On, changing the source power level will affect the accuracy of 
the current calibration. The correction will remain On and can be used, but an indicator (?P) 
will appear next to the left-hand status column (CAL: ON) to note that the current power 
setting is different from the one used during the calibration processes. 

No valid calibration to change correction.

There is no valid calibration in volatile memory that can be used to turn Cal Correction On. A 
new calibration must be performed. 

Cannot continue with calculating. 

Cannot continue with calculating. Not all required cal steps are completed. 

When performing a calibration, you must complete all of the required steps before applying 
the “Calculate and Finish Cal” step.

Bias Tee state cannot be changed during calibration. 

While performing a calibration, and before completing all of the calibration steps, you cannot 
turn on the Bias Tee. You must wait till after all of the calibration steps are complete before 
turning on the Bias Tee. This precaution is enforced to protect the calibration components 
from getting damaged by the Bias Tee current.

Turning Bias Tee to OFF. 

Bias Tee was turned on when a new calibration sequence was started. The Bias Tee was 
turned off to protect the calibration components. After all the calibration steps are completed, 
you can turn the Bias Tee back on as required.
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Turning Bias Tee to OFF. 

Turning Bias Tee to OFF. Recalling measurement does not match with current setup.

The recalled measurement file does not match the current setup. To ensure DUT safety, the 
Bias Tee function is turned off.

Turning Bias Tee to OFF. 

Turning Bias Tee to OFF. Recalling setup does not match with current setup.

The recalled setup file does not match the current setup. To ensure DUT safety, the Bias Tee 
function is turned off.

Calibration will be lost after change.   

Calibration will be lost after change. Press the button again to continue.

While performing a calibration, and before completing all the calibration steps, if you change 
any of the frequency parameters (start, stop, center, span) or the number of points, then the 
calibration must be invalidated. 

Changes not allowed during calibration. 

Changes not allowed during calibration. Press Esc to abort calibration.

Certain parameters (such as frequency and number of points) are able to be changed while 
the calibration process is underway. Changing these parameters is not allowed unless the 
calibration is aborted first.

Option 10 (Bias Tee) not enabled.

To turn on the internal or external Bias Tee, Option 10 must be enabled in the instrument. 
Contact your Anritsu Service Center to inquire about enabling this option.

No External Reference signal detected.

External Reference was switched to 10 MHz but no external 10 MHz signal was detected. The 
External Reference setting is turned back to Off. Check the external reference level and 
frequency, and then try again.

Limit is not available for this Graph type.

Limits are supported only for rectilinear graph types (not for Smith Charts, for example).
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Appendix D — Tower Mounted 
Amplifiers

D-1 Introduction    
A Tower Mounted Amplifier (TMA) can be used to amplify the received signal. There are 
different types of TMA depending on the system requirements. Three commonly used types 
are:

• TMA-D - A duplex tower mounted amplifier that combines transmit and receive 
ports from the radio system and connects to a single antenna. This configuration 
is specific to systems that use a single antenna configuration.

• TMA-S - A receive-only tower mounted amplifier is installed between the 
receiving antenna and the radio to boost weak signals. This configuration is 
common on systems that implement separate antennas for transmitting and 
receiving.

• TMA-DD - A dual-duplex tower mounted amplifier used for radios systems with a 
single transmission line connection for transmit and receive. These systems are 
commonly called transceivers.

Figure D-1. Tower Mounted Amplifiers
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Appendix E — Coaxial Cable 
Technical Data

E-1 Coaxial Cable Technical Data
The table below provides a list of common coaxial cables. 

Table E-1. Coaxial Cable Technical Data  (Sheet 1 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3

Andrew FSJ1-50A (6 GHz) 0.84 1000 0.196 2500 0.313 6000 0.532

Andrew FSJ2-50 (6 GHz) 0.83 1000 0.133 2500 0.223 6000 0.374

Andrew FSJ4-50B (6 GHz) 0.81 1000 0.118 2500 0.201 6000 0.348

Andrew EFX2-50 (6 GHz) 0.85 1000 0.121 2500 0.202 6000 0.341

Andrew LDF1-50 (6 GHz) 0.86 6000 0.306 6000 0.306 6000 0.306

Andrew LDF2-50 (6 GHz) 0.88 6000 0.323 6000 0.323 6000 0.323

Andrew LDF4-50A (6 GHz) 0.88 1000 0.073 2500 0.121 6000 0.218

Andrew HJ4-50 (6 GHz) 0.914 1000 0.092 2500 0.156 6000 0.257

Andrew HJ4.5-50 (6 GHz) 0.92 1000 0.054 2500 0.089 6000 0.148

Andrew AVA5-50 7/8 0.91 1000 0.038 2000 0.055 2500 0.063

Andrew AVA7-50 1-5/8 0.92 1000 0.022 2000 0.034 2500 0.038

Andrew EFX2-50 0.85 1000 0.121 2000 0.177 2500 0.202

Andrew FLC 12-50J 0.88 1000 0.075 2000 0.11 2500 0.134

Andrew FLC 38-50J 0.88 1000 0.115 2000 0.169 2500 0.19

Andrew FLC 78-50J 0.88 1000 0.041 2000 0.061 2500 0.072

Andrew FLC 114-50J 0.88 1000 0.033 2000 0.05 2500 0.059

Andrew FLC 158-50J 0.88 1000 0.025 2000 0.038 2500 0.042

Andrew FSJ1-50A 0.84 1000 0.196 2000 0.285 2500 0.313

Andrew FSJ2-50 0.83 1000 0.133 2000 0.196 2500 0.223

Andrew FSJ4-50B 0.81 1000 0.118 2000 0.176 2500 0.201

Andrew HJ4-50 0.91 1000 0.092 2000 0.137 2500 0.156

Andrew HJ4.5-50 0.92 1000 0.054 2000 0.079 2500 0.089

Andrew HJ5-50 0.916 1000 0.042 2000 0.063 2500 0.071

Andrew HJ7-50A 0.921 1000 0.023 2000 0.034 2500 0.039

Andrew HJ12-50 0.931 1000 0.019 2000 0.029 2000 0.029

Andrew HL4RP-50A 0.88 1000 0.074 2000 0.109 2500 0.123

Andrew LDF4-50A 0.88 1000 0.073 2000 0.107 2500 0.12
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Andrew LDF4.5-50 0.89 1000 0.054 2000 0.08 2500 0.091

Andrew LDF5-50A 0.89 1000 0.041 2000 0.061 2500 0.07

Andrew LDF5-50B 0.91 1000 0.041 2000 0.061 2500 0.07

Andrew LDF6-50 0.89 1000 0.028 2000 0.042 2500 0.048

Andrew LDF7-50A 0.88 1000 0.024 2000 0.037 2500 0.043

Andrew LDF12-50 0.88 1000 0.021 2000 0.033 2000 0.033

Andrew VXL5-50 7/8 0.88 1000 0.045 2000 0.066 2500 0.075

Andrew VXL6-50 1-1/4 0.88 1000 0.032 2000 0.048 2500 0.055

Andrew VXL7-50 1-5/8 0.88 1000 0.024 2000 0.037 2500 0.043

Belden RG-8/8A 0.86 1000 0.132 2000 0.33 2500 0.22

Belden RG-9/9A 0.659 1000 0.289 1000 0.289 1000 0.289

Belden RG-17/17A 0.659 1000 0.18 1000 0.18 1000 0.18

Belden RG-55/55A/55B 0.659 1000 0.541 1000 0.541 1000 0.541

Belden RG-58/58B 0.77 1000 0.356 2000 0.528 2500 0.6

Belden RG-58A/58C 0.73 1000 0.594 1000 0.594 1000 0.594

Belden RG-142 0.7 1000 0.43 2000 0.663 2500 0.713

Belden RG-174 0.66 1000 1.115 1000 1.115 1000 1.115

Belden RG-178B 0.695 1000 1.509 1000 1.509 1000 1.509

Belden RG-188 0.69 1000 0.951 1000 0.951 1000 0.951

Belden RG-213 0.66 1000 0.262 1000 0.269 1000 0.269

Belden RG-214 0.659 1000 0.229 1000 0.292 1000 0.292

Belden RG-223 0.66 1000 0.476 1000 0.478 1000 0.478

Cablewave HCC 12-50J 0.915 1000 0.087 2000 0.126 2500 0.137

Cablewave HCC 78-50J 0.915 1000 0.041 2000 0.061 2500 0.066

Cablewave HCC 158-50J 0.95 1000 0.022 2000 0.031 2500 0.033

Cablewave HCC 300-50J 0.96 1000 0.015 1000 0.015 1000 0.015

Cablewave HCC 312-50J 0.96 1000 0.013 1000 0.013 1000 0.013

Cablewave HF 4 1/8 Cu2Y 0.97 1000 0.01 1000 0.01 1000 0.01

Cablewave HF 5 Cu2Y 0.96 1000 0.007 1000 0.007 1000 0.007

Cablewave HF 6 1/8 Cu2Y 0.97 1000 0.006 1000 0.006 1000 0.006

Cellflex LCF78-50JA 0.9 1000 0.039 2000 0.058 2500 0.066

Cellflex LCFS114-50JA 0.9 1000 0.029 2000 0.044 2500 0.051

Cellflex LCF158-50JA 0.9 1000 0.024 2000 0.036 2500 0.042

Cellflex LCF214-50JA 0.88 1000 0.021 2000 0.033 2000 0.033

Cellflex UCF114-50JA 0.89 1000 0.031 2000 0.047 2000 0.047

Table E-1. Coaxial Cable Technical Data  (Sheet 2 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Comscope CR50 540PE 0.88 1000 0.069 2000 0.103 2500 0.116

Comscope CR50 1070PE 0.88 1000 0.037 2000 0.055 2500 0.064

Comscope CR50 1873PE 0.88 1000 0.022 2000 0.034 2500 0.04

Eupen EC4-50-HF 1/2 0.82 1000 0.108 2000 0.161 2500 0.183

Eupen EC4-50 1/2 0.88 1000 0.074 2000 0.109 2500 0.121

Eupen EC4.5-50 5/8 0.88 1000 0.056 2000 0.083 2500 0.094

Eupen EC5-50 7/8 0.88 1000 0.04 2000 0.058 2500 0.066

Eupen EC6-50 1-1/4 0.88 1000 0.028 2000 0.043 2500 0.048

Eupen EC7-50 1-5/8 0.88 1000 0.024 2000 0.037 2500 0.042

Eupen EC7-50A 1-5/8 0.89 1000 0.023 2000 0.035 2500 0.039

Eupen EC12-50 2-1/4 0.88 1000 0.022 2000 0.034 2500 0.039

Nk Cables RF1/2-50 0.88 1000 0.073 2000 0.107 2500 0.127

Nk Cables RF1/2-50GHF 0.88 1000 0.073 2000 0.107 2500 0.127

Nk Cables RF1/2-50BHF 0.88 1000 0.073 2000 0.107 2500 0.127

Nk Cables RF5/8-50 0.88 1000 0.051 2000 0.075 2500 0.087

Nk Cables RF5/8-50GHF 0.88 1000 0.051 2000 0.075 2500 0.087

Nk Cables RF5/8-50BHF 0.88 1000 0.051 2000 0.075 2500 0.087

Nk Cables RF7/8-50 0.88 1000 0.04 2000 0.059 2500 0.07

Nk Cables RF7/8-50GHF 0.88 1000 0.04 2000 0.059 2500 0.07

Nk Cables RF7/8-50BHF 0.88 1000 0.04 2000 0.059 2500 0.07

Nk Cables RF1 5/8-50 0.88 1000 0.024 2000 0.036 2500 0.042

Nk Cables RF1 5/8-50GHF 0.88 1000 0.024 2000 0.036 2500 0.042

Nk Cables RF1 5/8-50BHF 0.88 1000 0.024 2000 0.036 2500 0.042

Nk Cables RF2 1/4-50 0.88 1000 0.021 2000 0.032 2500 0.041

Nk Cables RF2 1/4-50GHF 0.88 1000 0.021 2000 0.032 2500 0.041

Nk Cables RF2 1/4-50BHF 0.88 1000 0.021 2000 0.032 2500 0.041

Nk Cables RFF3/8-50 0.81 1000 0.147 2000 0.218 2500 0.25

Nk Cables RFF3/8-50GHF 0.81 1000 0.147 2000 0.218 2500 0.25

Nk Cables RFF3/8-50BHF 0.81 1000 0.147 2000 0.218 2500 0.25

Nk Cables RFF1/2-50 0.82 1000 0.112 2000 0.167 2500 0.19

Nk Cables RFF1/2-50GHF 0.82 1000 0.112 2000 0.167 2500 0.19

Nk Cables RFF1/2-50BHF 0.82 1000 0.112 2000 0.167 2500 0.19

Nk Cables RFF7/8-50 0.88 1000 0.04 2000 0.066 2500 0.076

Nk Cables RFF7/8-50GHF 0.88 1000 0.04 2000 0.066 2500 0.076

Nk Cables RFF7/8-50BHF 0.88 1000 0.04 2000 0.066 2500 0.076

Table E-1. Coaxial Cable Technical Data  (Sheet 3 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Times LMR100 0.66 1000 0.789 2000 1.15 2500 1.31

Times LMR200 0.83 1000 0.342 2000 0.49 2500 0.554

Times LMR240 0.84 1000 0.261 2000 0.377 2500 0.424

Times LMR400 0.85 1000 0.135 2000 0.196 2500 0.222

Times LMR500 0.86 1000 0.109 2000 0.159 2500 0.18

Times LMR600 0.87 1000 0.087 2000 0.128 2500 0.145

Times LMR900 0.87 1000 0.059 2000 0.086 2500 0.098

Times LMR1200 0.88 1000 0.044 2000 0.065 2500 0.074

Times LMR1700 0.89 1000 0.033 2000 0.049 2500 0.057

 310801 0.821 1000 0.115 1000 0.115 1000 0.115

 311201 0.82 1000 0.18 1000 0.18 1000 0.18

 311501 0.8 1000 0.23 1000 0.23 1000 0.23

 311601 0.8 1000 0.262 1000 0.262 1000 0.262

 311901 0.8 1000 0.377 1000 0.377 1000 0.377

 352001 0.8 1000 0.377 1000 0.377 1000 0.377

Table E-1. Coaxial Cable Technical Data  (Sheet 4 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Appendix F — Waveguide Data

F-1 Introduction
This appendix provides lists of waveguide components and their characteristics.

F-2 Calibration Components
The calibration components part numbers in the following table are broken down as follows, 
where the xx in the part number column (as in xxUM70) is replaced as follows:

xx:    23 = 1/8 Offset Short

24 = 3/8 Offset Short

26 = Precision Load

Table F-1. Precision Waveguide Calibration Components 

Part Number Freq. Range (GHz) Waveguide Type Compatible Flanges

xxUM70 5.85 to 8.20 WR137, WG14 CAR70, PAR70, UAR 70, PDR70

xxUM84 7.05 to 10.00 WR112, WG15 CBR84, UBR84, PBR84, PDR84

xxUM100 8.20 to 12.40 WR90, WG16 CBR100, UBR100, PBR100, 
PDR100

xxUM120 10.00 to 15.00 WR75, WG17 CBR120, UBR120, PBR120, 
PDR120

xxUA187 3.95 to 5.85 WR187, WG12 CPR187F, CPR187G, 
UG-1352/U, UG-1353/U, 
UG-1728/U, UG-1729/U, 
UG-148/U, UG-149A/U

xxUA137 5.85 to 8.20 WR137, WG14 CPR137F, CPR137G, 
UG-1356/U, UG-1357/U, 
UG-1732/U, UG-1733/U, 
UG-343B/U, UG-344/U, 
UG-440B/U, UG-441/U

xxUA112 7.05 to 10.00 WR112, WG15 CPR112F, CPR112G, UG-1358/U, 
UG-1359/U, UG-1734/U, 
UG-1735/U, UG-52B/U, UG-51/U, 
UG-137B/U, UG-138/U

xxUA90 8.20 to 12.40 WR90, WG16 CPR90F, CPR90G, 
UG-1360/U, UG-1361/U, 
UG-1736/U, UG-1737/U, 
UG-40B/U, UG-39/U, 
UG-135/U, UG-136B/U
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F-3 Waveguide-to-Coaxial Adapters
Part numbers that end with N have Type N connectors, part numbers that end with K have 
K Connectors. 

xxUA62 12.40 to 18.00 WR62, WG18 UG-541A/U, UG-419/U, 
UG-1665/U, UG1666/U

xxUA42 17.00 to 26.50 WR42, WG20 UG-596A/U, UG-595/U, 
UG-597/U, UG-598A/U

Table F-2. Coaxial to Universal Waveguide Adapters 

Part Number Freq. Range (GHz) Waveguide Type Compatible Flanges

35UM70N 5.85 to 8.20 WR137, WG14 CAR70, PAR70, UAR 70, 
PDR70

35UM84N 7.05 to 10.00 WR112, WG15 CBR84, UBR84, PBR84, PDR84

35UM100N 8.20 to 12.40 WR90, WG16 CBR100, UBR100, PBR100, 
PDR100

35UM120N 10.00 to 15.00 WR75, WG17 CBR120, UBR120, PBR120, 
PDR120

35UA187N 3.95 to 5.85 WR187, WG12 CPR187F, CPR187G, 
UG-1352/U, UG-1353/U, 
UG-1728/U, UG-1729/U, 
UG-148/U, UG-149A/U

35UA137N 5.85 to 8.20 WR137, WG14 CPR137F, CPR137G, 
UG-1356/U, UG-1357/U, 
UG-1732/U, UG-1733/U, 
UG-343B/U, UG-344/U, 
UG-440B/U, UG-441/U

35UA112N 7.05 to 10.00 WR112, WG15 CPR112F, CPR112G, 
UG-1358/U, UG-1359/U, 
UG-1734/U, UG-1735/U, 
UG-52B/U, UG-51/U, 
UG-137B/U, UG-138/U

35UA90N 8.20 to 12.40 WR90, WG16 CPR90F, CPR90G, 
UG-1360/U, UG-1361/U, 
UG-1736/U, UG-1737/U, 
UG-40B/U, UG-39/U, 
UG-135/U, UG-136B/U

35UA62N 12.40 to 18.00 WR62, WG18 UG-541A/U, UG-419/U, 
UG-1665/U, UG1666/U

35UA42K 7.00 to 26.50 WR42, WG20 UG-596A/U, UG-595/U, 
UG-597/U, UG-598A/U

Table F-1. Precision Waveguide Calibration Components  (Continued)

Part Number Freq. Range (GHz) Waveguide Type Compatible Flanges
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F-4 Flange Compatibility 

Table F-3. Universal Flange Compatibility (1 of 3) 

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type
Flange
Type

Compatible 
Flanges

xxUM40 3.300 4.900 WR229 
WG11A

UnivM-229 PDR40

xxUM48 3.950 5.850 WR187 
WG12

UnivM-187 CAR48 
PAR48 
UAR48 
PDR48

xxUM58 4.900 7.050 WR159 
WG13

UnivM-159 CAR58 
PAR58 
UAR58 
PDR58

xxUM70 5.850 8.200 WR137 
WG14

UnivM-137 CAR70 
PAR70 
UAR70 
PDR70

xxUM84 7.050 10.000 WR112 WG15 UnivM-112 CBR84 
UBR84 
PBR84 
PDR84

xxUM100 8.200 12.400 WR90 WG16 UnivM-90 CBR100 
UBR100 
PBR100 
PDR100

xxUM120 10.000 15.000 WR75 WG17 UnivM-75 CBR120 
UBR120 
PBR120 
PDR120

xxUM140 12.400 18.000 WR62 WG18 UnivM-62 CBR140 
UBR140 
PBR140 
PDR140

xxUM220 17.000 26.500 WR42 WG20 UnivM-42 CBR220 
UBR220 
PBR220 
PDR220

xxUA229 3.300 4.900 WR229 
WG11A

UnivUS-229 CPR229F 
CPR229G 
UG-1350/U 
UG-1351/U 
UG-1726/U 
UG-1727/U
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Universal Flange Compatibility 

Table F-4. Universal Flange Compatibility (2 of 3) 

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type
Flange
Type

Compatible 
Flanges

xxUA187 3.950 5.850 WR187 
WG12

UnivUS-187 CPR187F 
CPR187G 
UG-1352/U 
UG-1353/U 
UG-1728/U 
UG-1729/U 
UG-148/U 
UG-149A/U

xxUA159 4.900 7.050 WR159 
WG13

UnivUS-159 CPR159F 
CPR159G 
UG-1354/U 
UG-1355/U 
UG-1730/U 
UG-1731/U

xxUA137 5.850 8.200 WR137 
WG14

UnivUS-137 CPR137F 
CPR137G 
UG-1356/U 
UG-1357/U 
UG-1732/U 
UG-1733/U 
UG-343B/U 
UG-344/U 
UG-440B/U 
UG-441/U

xxUA112 7.050 10.00 WR112 WG15 UnivUS-112 CPR112F 
CPR112G 
UG-1358/U 
UG-1359/U 
UG-1734/U 
UG-1735/U 
UG-52B/U 
UG-51/U 
UG-137B/U 
UG-138/U
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xxUA90 8.200 12.400 WR90 WG16 UnivUS-90 CPR90F 
CPR90G 
UG-1360/U 
UG-1361/U 
UG-1736/U 
UG-1737/U 
UG-40B/U 
UG-39/U 
UG-135/U 
UG-136B/U

xxUA75 10.000 15.000 WR75 WG17 UnivUS-75 WR75

Table F-4. Universal Flange Compatibility (2 of 3)  (Continued)

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type
Flange
Type

Compatible 
Flanges
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Universal Flange Compatibility 

Table F-5. Universal Flange Compatibility (3 of 3) 

Calibration 
Component 
Part Number

Start 
Frequency 

(GHz)

Stop 
Frequency 

(GHz)
Waveguide 

Type Flange Type
Compatible 

Flanges

xxUA62 12.400 18.000 WR62
WG18

UnivUS-62 UG-541A/U 
UG-419/U 
UG-1665/U 
UG-1666/U

xxUA42 17.000 26.500 WR42
WG20

UnivUS-42 UG-596A/U 
UG-595/U 
UG-597/U 
UG-598A/U

xxCMR229 3.300 4.900 WR229 
WG11A

CMR229 CMR229

xxCMR187 3.950 5.850 WR187 
WG12

CMR187 CMR187 
UG-1475/U 
UG-1480/U

xxCMR159 4.900 7.050 WR159 
WG13

CMR159 CMR159

xxCMR137 5.850 8.200 WR137 
WG14

CMR137 CMR137 
UG-1476/U 
UG-1481/U

xxCMR112 7.050 10.000 WR112 
WG15

CMR112 CMR112 
UG-1477/U 
UG-1482/U

xxCMR90 8.200 12.400 WR90
WG16

CMR90 CMR90 
UG-1478/U 
UG-1483/U

xxUER40 3.300 4.900 WR229 
WG11A

UER40 UER40

xxUER48 3.950 5.850 WR187 
WG12

UER48 UER48

xxUER58 4.900 7.050 WR159 
WG13

UER58 UER58

xxUER70 5.850 8.200 WR137 
WG14

UER70 UER70

xxUER84 7.050 10.000 WR112 
WG15

UER84 UER84

xxUER100 8.200 12.400 WR90
WG16

UER100 UER100
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F-5 Waveguide Technical Data 

Table F-6. Waveguide Offset Shorta Specifications 

a.Offset shorts are 3/8 wave at the geometric mean frequency waveguide band and dimensionally accurate 
to <0.5 degree at the maximum operating frequency of the corresponding wavelength.

Offset Short P/N Frequency (GHz) Length (mm)

24UM70 6.926 20,710 +/- 0.08

24UM84 8.396 17,040 +/- 0.05

24UM100 10.084 14,675 +/- 0.05

24UM120 12.247 11,978 +/- 0.04

24UA187 4.807 30,979 +/- 0.11

24UA137 6.926 20,710 +/- 0.08

24UA112 8.396 17,040 +/- 0.05

24UA90 10.084 14,675 +/- 0.05

24UA62 14.940 9,742 +/- 0.04

24UA42 21.225 7,067 +/- 0.03

24CMR187 4.807 30,979 +/- 0.11

24CMR137 6.926 20,710 +/- 0.08

24CMR112 8.396 17,040 +/- 0.05

24CMR90 10.084 14,675 +/- 0.05

24UER70 6.926 20,710 +/- 0.08

24UER84 8.396 17,040 +/- 0.05

24UER100 10.084 14,675 +/- 0.05
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Waveguide Technical Data 

Table F-7. Waveguide Technical Data (Sheet 1 of 2)

Waveguide 
Type/Model

Start Frequency 
(GHz)

Stop Frequency 
(GHz)

Cutoff 
Frequency 

(GHz)
Mid-Band Loss 

(dB/m)

WR229, WG11A 3.300 4.900 2.577 0.0374

WR187, WG12 3.950 5.850 3.152 0.0515

WR159, WG13 4.900 7.050 3.711 0.0591

WR137, WG14 5.850 8.200 4.301 0.0738

WR112, WG15 7.050 10.000 5.259 0.1024

WR102 7.000 11.000 5.786 0.1083

WR90, WG16 8.200 12.400 6.557 0.1578

WR75, WG17 10.000 15.000 7.868 0.1913

WR67 11.000 17.000 8.578 0.2159

WR62, WG18 12.400 18.000 9.486 0.2411

WR51, WG19 15.000 22.000 11.574 0.3691

WR42, WG20 17.000 26.500 14.047 0.5200

Andrew

EW17 1.700 2.400 1.364 0.012

EW20 1.900 2.700 1.57 0.015

EW28 2.600 3.400 2.2 0.021

EW34 3.100 4.200 2.376 0.0223

EW37 3.300 4.300 2.790 0.0292

EW43 4.400 5.000 2.780 0.0289

EW52 4.600 6.425 3.650 0.042

EW63 5.580 7.125 4.000 0.0453

EW64 5.300 7.750 4.320 0.052

EW77 6.100 8.500 4.720 0.061

EW85 7.700 9.800 6.460 0.1086

EW90 8.300 11.700 6.500 0.108

EW127 10.000 13.250 7.670 0.124

EW132 11.000 15.350 9.220 0.17

EW180 14.000 19.700 11.150 0.1939

EW220 17.000 23.600 13.340 0.2822
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Cablewave

WE37 3.600 4.200 2.830 0.0269

WE46 4.400 5.000 3.000 0.0354

WE61 5.925 6.425 3.600 0.0390

WE65 6.425 7.125 4.000 0.0453

WE70 7.125 7.750 4.300 0.0404

WE78 7.125 8.500 4.670 0.0446

WE108 10.500 11.700 6.570 0.0978

WE130 11.700 13.250 7.430 0.1142

WE150 14.000 15.350 8.600 0.1398

WE191 17.700 19.700 10.680 0.1952

RFS Cablewave

E20 1.700 2.300 1.38 0.012

E30 2.300 3.100 1.8 0.016

E38 3.000 4.200 2.4 0.025

E46 3.650 5.000 2.88 0.028

ES46 3.900 5.000 3.08 0.036

E60 4.500 6.425 3.65 0.045

E65 5.000 7.125 4.01 0.05

E78 5.900 8.500 4.72 0.06

E105 8.100 11.700 6.49 0.09

E130 9.300 13.250 7.43 0.12

E150 10.800 15.350 8.64 0.15

E185 13.700 19.700 11.06 0.2

E220 16.700 23.600 13.36 0.29

Table F-7. Waveguide Technical Data (Sheet 2 of 2)

Waveguide 
Type/Model

Start Frequency 
(GHz)

Stop Frequency 
(GHz)

Cutoff 
Frequency 

(GHz)
Mid-Band Loss 

(dB/m)
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Appendix G — More About DHCP

G-1 Introduction
DHCP stands for Dynamic Host Configuration Protocol. This protocol allows a server to 
dynamically assign IP addresses to devices that are connected to the network. Most networks 
include a DHCP server to manage IP addresses. When a DHCP server is available on the 
network, DHCP is the preferred IP address mode.

G-2 Ethernet Configuration

LAN Connection 

The RJ-45 connector is used to connect the VNA Master to a local area network. Integrated 
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN 
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to 
show that LAN traffic is present. The instrument IP address is set by pressing the Shift key, 
then the System (8) key followed by the System Options submenu key and the Ethernet Config 
submenu key. The instrument Ethernet address can be set automatically using DHCP, or 
manually by entering the desired IP address, gateway address, and subnet mask. 

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP, and is the most common method 
of configuring a device for network use. To determine if a network is set up for DHCP, connect 
the MS20xxC to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the VNA Master off, and then on. If the network is set up for DHCP, then the assigned 
IP address should be displayed briefly after the power up sequence.

Note

An active Ethernet cable must be connected to the instrument before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address.

Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable.

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the instrument before cycling the power OFF and back ON.
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To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options submenu key and the Ethernet Config submenu key. The IP address 
will be displayed as shown in Figure G-1. The image on the display panel of your VNA Master 
may differ from the image shown here. 

Figure G-1. IP Address Assigned Using DHCP
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Ethernet Config 

Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor 
dialog box in order to set the IP address of the instrument. 

Figure G-2. Setting IP Address Manually
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Ethernet Menu  

Key Sequence: Shift, System (8) > System Options > Ethernet Config 

G-3 Using DHCP
When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic 
IP operation, the assigned IP address may change from use to use. The DHCP server assigns 
IP addresses on a time rotation basis. As soon as the device is disconnected from the network, 
the IP address that it was using becomes available to lease to the next unit requesting an IP 
address. Normally, some amount of lag time occurs on the DHCP server end, so if the device 
is connected again reasonably soon, it may receive the same address.

G-4 Static IP Address
When a DHCP server is not available, a Static IP address can be used. A Static IP address is 
a fixed address. After being set, it will always remain the same, and care must be taken to 
avoid conflict with other equipment on the network.

Type
Manual DHCP: Press this submenu key to select whether the address will 
be entered manually, or will be supplied automatically by a network DHCP 
server. If Manual is selected, then use the submenu keys or the Left/Right 
arrow keys to select the field that is to be modified. Use the keypad, the Up/
Down arrow keys, or the rotary knob to enter the input. Press Enter to accept 
the changes, or press the Esc key to return to normal operation without 
changing anything.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet Pro-
tocol Property to be edited.

First Octet: Moves the cursor to the left most column of the selected IP prop-
erties field.

Second Octet: Moves the cursor to the second column from the left of the 
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the 
selected IP properties field.

Fourth Octet: Moves the cursor to the forth column from the left of the 
selected IP properties field.

Figure G-3. Ethernet Menu

Note
The VNA Master must be connected to the network before it is turned on in order 
to allow DHCP to work. Key elements of the DHCP lease are performed only 
during the instrument startup operations or when switching from manual to DHCP.

Ethernet

Type

Manual         DHCP

Field

IP     G-Way    Sub

First Octet

Second Octet

Third Octet

Fourth Octet



More About DHCP G-5 Operating System Tools

MS20xxC UG PN: 10580-00305  Rev. J G-5

When using a static IP address on an established network, always request a Static IP address 
from the network administrator. Randomly choosing a Static IP address on an established 
network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a Static IP address:

IP Address

This is the Static IP address on the network.

Default Gateway

Often when a static IP address is assigned, a default gateway is also identified. If the default 
gateway is unknown, then type in the Static IP address so that the Static IP address and 
Default Gateway are the same number.

Subnet Mask

This parameter is usually extracted from the Static IP address based upon the class of the 
address. It determines the destination of any broadcast messages that might be sent from the 
instrument. It can be customized if necessary. The subnet mask may also be provided with 
the Static IP address.

Example 1

In this example, a Static IP address has been chosen because no network is available. The 
instrument is connected to the network port on the PC with a crossover Ethernet cable (not 
included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2
Default Gateway: 10.0.0.2
Subnet Mask: 255.255.0.0

Example 2

In this example, the Static IP address has been assigned with an associated gateway and 
subnet mask:

IP Address: 153.56.100.42
Default Gateway: 153.56.100.1
Subnet Mask: 255.255.252.0

G-5 Operating System Tools
A few tools that are built into the Microsoft Windows operating system can assist in making 
some determinations about the network that the PC is plugged into. 
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Ipconfig Tool

Typing ipconfig at a command prompt will display information about the in-use parameters of 
the PC and its network connection. Below is an example of the typical results expected. 

Y:\>ipconfig
Windows 2000 IP Configuration
Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix. : us.anritsu.com
IP Address . . . . . . . . . . . . : 172.26.202.172
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.26.200.1

Ping Tool

Another tool that can find out if a selected IP address is already on the network is ping. Ping 
is a harmless way to determine if an address is found on the network and, if it is found, for it 
to reply. Greatly simplified, ping sends out a request to a specific address to determine if it is 
there. If the specific address is found, then it will respond by sending back the same message 
that was received. If it is not found, then the response will be “request timed out.” This means 
that no reply was received from that IP address.

Y:\>ping 172.26.202.172
Pinging 172.26.202.172 with 32 bytes of data:
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Ping statistics for 172.26.202.172:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:
Minimum = 0ms, Maximum = 0ms, Average = 0ms

Note
The ipconfig display does not report if the information is from a DHCP server or a 
Static IP setup



More About DHCP G-5 Operating System Tools

MS20xxC UG PN: 10580-00305  Rev. J G-7



G-5 Operating System Tools More About DHCP

G-8 PN: 10580-00305  Rev. J MS20xxC UG



MS20xxC UG PN: 10580-00305  Rev. J H-1

Appendix H — Glossary of Terms
Introduction
The following terms are used in this manual.
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Glossary Terms

Adapter : A fitting that supplies a passage between two sets of equipment when 
they cannot be directly interconnected. 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 

Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

BER : Bit Error Rate or Bit Error Ratio (link quality specification/testing) 
(BER) &nbsp;BER is a measure of transmission quality. &nbsp;The 
ratio of error bits to the total number of bits transmitted. &nbsp;A bit 
error rate of 10-6 refers to an average of one error per million bits. 
&nbsp;It is generally shown as a negative exponent, (for example, 10-7 
which means 1 out of 107 bits are in error or 1 out of 10,000,000 bits are 
in error). &nbsp;&nbsp;Bit Error Rate (BER) is the fraction of a 
sequence of message bits that are in error. 

BERT : Bit Error Rate Test/Tester (BERT) &nbsp;BERT is a test that gauges 
the quality of the T1 or digital line. &nbsp;By sending a known pattern 
to another device across the span the far end device can compare 
incoming pattern to its’ own, thereby indicating bit errors on the line. 

Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 

Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
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itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 

dB : Decibel or deciBel (dB) is a unit for measuring relative power ratios in 
terms of gain or loss. The units of dB are expressed in terms of the 
logarithm to base 10 of a ratio and typically are expressed in watts. For 
example, a -3dB loss indicates a 50% loss in power; a +3dB reading is a 
doubling of power; 10 dB indicates an increase (or a loss) by a factor of 
10; 20 dB indicates an increase (or a loss) of a factor of 100; 30 dB 
indicates an increase (or a loss) by a factor of 1000. 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. A typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 

dBm : dBm is a decibel value referenced to a milliWatt (dBm) &nbsp;This is a 
technique for expressing a power measurement in logarithmic form 
using 1 mW as a reference. &nbsp;dBm is a decibel ratio (log 10) of 
Watts (W) to one milliwatt (1mW). &nbsp;dBm therefore represents 
absolute power. 

DTF : Distance-To-Fault (DTF) &nbsp;&nbsp;DTF is the distance from the 
instrument output connector (or the end of a test lead) to a problem 
area, as indicated by a peak in the displayed signal. 

FFT : Fast Fourier Transform (FFT) is an efficient algorithm to compute the 
Discrete Fourier transform (DFT) and its inverse. FFTs are of great 
importance to a wide variety of applications, from digital signal 
processing to solving partial differential equations to algorithms for 
quickly multiplying large integers. 

Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. It is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. It is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 

GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 to 100 meters. The 
satellites use simple mathematical calculations to broadcast 
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information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

IF : Intermediate Frequency (IF) is a frequency to which a carrier frequency 
is shifted as an intermediate step in transmission or reception. An 
intermediate electromagnetic frequency is generated by a 
superheterodyne radio receiver. 

IP Address : An Internet Protocol address (IP address) is usually a numerical label 
that is assigned to each device (computer or printer for example) that is 
participating in a computer network that uses the Internet Protocol for 
communication. An IP address serves two main functions: location 
addressing and host (or network) interface identification. The Internet 
Protocol originally defined an IP address as a 32-bit number. This was 
known as Internet Protocol Version 4 (IPv4), which is still in use. 
Growth of the Internet requires a new addressing system. An Internet 
Protocol Version 6 (IPv6) that uses 128 bits for the address was 
developed in 1995, and it is standardized as RFC 2460. IPv6 began 
being deployed worldwide in the year 2000. IP addresses are binary 
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numbers, but they are usually stored in text files and displayed in 
human-readable notations, such as decimal nnn.nnn.nnn.nnn or 
172.16.255.1 (for IPv4), and hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal 
group (nnn) represents values from 000 to 255, or binary values of 8 
bits. In IPv6, each hexadecimal group (nnnn) represents values from 
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 
1111 1111 1111). 

IPv6 : Internet Protocol Version 6 (IPv6) is a numerical label that is used to 
identify a network interface of a computer or other network node 
participating in an IPV6-enabled computer network. IPv6 uses 128 bits 
for the address (as compared to an IPv4 address, which is defined as a 
32-bit number). IPv6 was developed in 1995, and it is standardized as 
RFC 2460. IPv6 began being deployed worldwide in the year 2000. IP 
addresses are binary numbers, but they are usually stored in text files 
and displayed in human-readable notations, such as hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec]). 
Each hexadecimal group (nnnn) represents values from 0000 to FFFF, 
or binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 
1111). 

LPA : Linear Power Amplifier (LPA) is the final amplification stage in a 
multicarrier transmitter that has been designed and optimized to 
produce a linear response. By operating in the linear mode, the 
amplifier reduces the non-linear effects that produce intermodulation 
products and side-lobe spectra that cause adjacent channel interference. 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. NF (the noise figure) is defined 
as the decibel value of the noise factor. NF = 10log (F) where log uses 
the base 10, or common log. This formula is valid only then the input 
termination is at standard noise temperature. 

OBW : Occupied Bandwidth (OBW) &nbsp;Occupied Bandwidth is a measure 
of the bandwidth containing 99% of the total integrated power of the 
transmitted spectrum, centered on the assigned channel frequency. 
&nbsp;Interference to other channels or to other systems can occur if 
OWB is too large. 

OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 
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RBW : Resolution Bandwidth (RBW) &nbsp;With spectrum analyzers, a 
narrow band filter is swept across a frequency span to create the 
spectrum display. &nbsp;The filter bandwidth (RBW) determines the 
frequency resolution across the frequency axis. 

Signal loss : Signal loss is the amount of signal strength that’s lost in antenna cable, 
connectors, and free space. Signal loss is measured in decibels. 

Smith Chart : A Smith Chart is a graphical aid for electrical and electronics 
characteristics in radio frequency (RF) circuits.&nbsp; Smith Chart was 
invented by Phillip Smith at Bell Laboratories in 1939.&nbsp; The 
chart can be used to display multiple parameters, such as impedance, 
and admittance. 

S-parameter : S-parameters are scattering parameters, and are a signal ratio of 
reflection and transmission measurements. For a 2-port network, four 
fundamental S-parameters can be measured, and they are defined as 
Sxy (where x and y are subscripts of S). The first number (x) is the port 
number into which the signal is being injected, and the second number 
(y) is the port number from which the signal is leaving. The 
S-parameter is the ratio of these two signals. S11 is Forward Reflection. 
&nbsp;S21 is Forward Transmisssion. S12 is Reverse Transmission. 
S22 is Reverese Reflection. 

TMA : A Tower Mounted Amplifier (TMA) amplifies signals from an antenna 
to reduce the noise figure of a base transceiver station (BTS). This helps 
to improve the overall sensitivity of the BTS. &nbsp;A TMA is a 
low-noise amplifier (LNA) that is usually mounted as close as practical 
to the antenna in Base Transceiver Stations or in mobile masts. When 
using a TMA, the antenna is able to receive weaker signals. 
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